
Communicator for Desktop 
Includes Single Sign-On (SSO) 

User Guide

Communicator Release 22.9  
February 2021 

U S E R  G U I D E | C L O U D  C O M M U N I C A T I O N S 



 

Page | 2  

Table of Contents 
1.0 About Communicator for Desktop .......................................................................................... 5 

2.0 Get Started ................................................................................................................................. 5 
2.1 Installation ............................................................................................................................... 5 
2.2 Sign In...................................................................................................................................... 5 
2.3 Main Window ........................................................................................................................... 6 
2.4 Communications View ............................................................................................................. 8 
2.5 Start Chat................................................................................................................................. 9 
2.6 Send File ................................................................................................................................. 9 
2.7 Send Email .............................................................................................................................. 9 
2.8 Make Audio or Video Call ........................................................................................................ 9 
2.9 Share Your Application or Desktop ......................................................................................... 9 
2.10 Active Communications ......................................................................................................... 10 
2.11 My Room ............................................................................................................................... 10 

2.11.1 Select Audio Devices .................................................................................................... 11 

3 Contacts................................................................................................................................... 12 
3.1 Add ........................................................................................................................................ 12 
3.2 Edit......................................................................................................................................... 13 
3.3 Filters ..................................................................................................................................... 13 

4 Presence .................................................................................................................................. 13 

5 Chat .......................................................................................................................................... 15 
5.1 Chat View .............................................................................................................................. 15 
5.2 File Transfer........................................................................................................................... 15 
5.3 Group Chat ............................................................................................................................ 16 

6 Audio and Video Calls ............................................................................................................ 16 
6.1 Call From Computer .............................................................................................................. 17 
6.2 Call From Phone .................................................................................................................... 18 
6.3 Answer Call ........................................................................................................................... 18 
6.4 Priority Alert ........................................................................................................................... 18 
6.5 Contact Name Lookup for Incoming Calls ............................................................................. 18 
6.6 Missed Call or Communication .............................................................................................. 18 
6.7 Full Screen in Video Call ....................................................................................................... 19 
6.8 Multiparty Sessions ............................................................................................................... 19 
6.9 Call Waiting ........................................................................................................................... 19 
6.10 Call Transfer .......................................................................................................................... 19 
6.11 Message Waiting Indication and Visual Voice Mail ............................................................... 19 
6.12 Call Park and Retrieve ........................................................................................................... 20 
6.13 Call Pull ................................................................................................................................. 20 
6.14 Call Recording Controls......................................................................................................... 21 
6.15 Moderator Controls ................................................................................................................ 21 



 

Page | 3  

6.16 Forced Logout ....................................................................................................................... 22 
6.17 Headset Support .................................................................................................................... 22 
6.18 Team Telephony (Busy Lamp Field) ..................................................................................... 23 
6.19 Executive-Assistant ............................................................................................................... 24 
6.20 Presence Rules and Silent Alerting ....................................................................................... 24 
6.21 Call Center Agent Login ........................................................................................................ 24 
6.22 Remote Control Event Package ............................................................................................ 25 

7 Application or Desktop Share ............................................................................................... 25 

8 My Room .................................................................................................................................. 26 
8.1 Guest Client ........................................................................................................................... 27 

9 Universal Search ..................................................................................................................... 27 

10 Full Enterprise Directory ........................................................................................................ 29 

11 Communications History ....................................................................................................... 30 

13 Callto, Tel URL, and Other URL Schemes ............................................................................ 30 

14 XMPP Security ......................................................................................................................... 31 

15 Outlook Add-in ........................................................................................................................ 31 
15.1 Introduction ............................................................................................................................ 31 
15.2 Supported Platforms .............................................................................................................. 31 
15.3 Log Files ................................................................................................................................ 32 
15.4 Windows Registry Entries ...................................................................................................... 32 
15.5 Installation ............................................................................................................................. 33 
15.6 Features ................................................................................................................................ 33 

15.6.1 Presence in Outlook ...................................................................................................... 34 
15.6.2 Contact Actions in Outlook ............................................................................................ 34 
15.6.3 Call Multiple Phone Numbers Configured for Communicator / Non-Communicator 

Contacts ........................................................................................................................ 35 
15.7 Uninstall Outlook Add-in for Communicator .......................................................................... 36 
15.8 End-User Configuration ......................................................................................................... 36 

15.8.1 SIP Address in Microsoft Outlook Contacts .................................................................. 36 

16 Webex Contact Center Integration ........................................................................................ 37 

17 Privacy Policy.......................................................................................................................... 37 

18 Accessibility Compliance ...................................................................................................... 37 

19 Google Analytics ..................................................................................................................... 38 

20 Preferences ............................................................................................................................. 38 
20.1 General .................................................................................................................................. 38 
Language ........................................................................................................................................ 38 
Login 38 
Notifications ..................................................................................................................................... 38 
Accessibility ..................................................................................................................................... 39 
20.2 Audio/Video ........................................................................................................................... 39 

20.2.1 Audio ............................................................................................................................. 39 



 

Page | 4  

20.3 Video ............................................................................................................................. 40 
20.4 Incoming Calls ....................................................................................................................... 40 
20.5 Outgoing Calls ....................................................................................................................... 40 
20.6 Voice Mail .............................................................................................................................. 40 
20.7 Services ................................................................................................................................. 40 
20.8 Integrations ............................................................................................................................ 40 
20.9 Advanced ............................................................................................................................... 40 
20.9.1 Troubleshooting ............................................................................................................. 41 
20.9.2 Proxy ............................................................................................................................. 41 

21 Call Settings ............................................................................................................................ 41 
21.1 Masergy (BroadWorks) Anywhere......................................................................................... 41 
21.2 Masergy (BroadWorks) Remote Office.................................................................................. 42 
21.3 Forward Calls ........................................................................................................................ 42 
21.4 Do Not Disturb ....................................................................................................................... 42 
21.5 Hide Number ......................................................................................................................... 42 
21.6 Simultaneous Ring Personal ................................................................................................. 42 
21.7 Voice Messaging ................................................................................................................... 42 
21.8 Anonymous Call Rejection .................................................................................................... 43 
21.9 Automatic Callback ................................................................................................................ 43 
21.10 Call Waiting ........................................................................................................................... 43 

22 Sign Out ................................................................................................................................... 43 
22.1 Sign Out of Communicator .................................................................................................... 43 
22.2 Exit Application ...................................................................................................................... 44 

23 Multi-Device Support .............................................................................................................. 44 

24 Installation ............................................................................................................................... 45 

25 Uninstallation .......................................................................................................................... 46 
25.1 Windows ................................................................................................................................ 46 
25.2 Mac OS .................................................................................................................................. 46 

26 Version Control and Automatic Upgrade .............................................................................. 46 

27 System Requirements ............................................................................................................ 47 

28 Troubleshooting ..................................................................................................................... 47 

Appendix A: Keyboard Shortcuts for Desktop .......................................................................... 53 

Appendix B: Guest Client Usage ................................................................................................. 55 

Appendix C: Configure USB Headsets ....................................................................................... 57 

Appendix D: Multi-Device Presence ............................................................................................ 60 

Appendix E: Third-Party Software and Copyright ..................................................................... 61 

Appendix F: Acronyms and Abbreviations ................................................................................ 62 



 

Page | 5  

1.0 About Communicator for Desktop 
Communicator for Desktop is a native Windows or Mac OS client for Unified Communications, 
providing the following communication features: 

 Instant Messaging and Presence 

 Voice Calling (VoIP) 

 Voice Calling (Desk phone) 

 Video Calling 

 Desktop Sharing 

 Masergy UC (BroadWorks) Call Settings 

2.0 Get Started 
This section contains the essential information for getting started with Communicator. End users 
must ensure they are using valid drivers for video (for example). Additionally, end users must make 
sure to always use the latest OS version with latest security updates. 

 

2.1 Installation 

Masergy provides the download of the installer. 

Windows 

 Double-click the MSI installer executable and follow the installation instructions. 

 Launch Communicator. 

Mac OS 

 Double-click the disk image. 

 Copy the application into the Applications folder. 

 Launch Communicator. 
 

2.2 Sign In 

When you first launch the application, you are prompted to sign in. 

Without Single Sign-On (SSO), the login flow is as follows: 

1) Enter your Masergy credentials, user name and password. 

2) Select whether you would like Communicator to remember your password. 

3) Select whether you would like Communicator to sign you in automatically on subsequent 
launches. 

4) Click Sign In. 

When Single Sign-On (SSO) is enabled, the login flow is typically as follows: 

1) Enter the Enterprise Domain for your company’s Identity Service Provider (IdP). 

2) As a result, an internal or external web browser opens. Provide the SSO credentials in the 
web browser view and return to the Communicator login view. When logging in for the 
second time using SSO, your previously used IdP is remembered automatically.  

3) Select whether you would like Communicator to sign you in automatically on subsequent 
launches. 

4) Click Sign In. 
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You can also access Help, Preferences, and login URL change view directly from the Login window. 
 

 

The Login window offers the last used username, but the password shall be automatically filled in 
only if you have checked the Save password check box. This checkbox is only available in non-SSO 
deployments. The purpose is to save you from re-typing the password at login. If multiple people 
use the same machine, only the last password is entered as a security measure. If you change the 
username in the Login window through editing it, or using the drop-down list to pick another one, 
Communicator will not fill in the password; you are always expected to type it in. This also applies 
when re-selecting or re- entering the last used username. 

If the DM URL is changed, the password is not remembered as a security feature. 

After logging in, a pop-up dialog may appear informing you about emergency calls, and another 
about changing your location for emergency calls. You may also see a banner in the Main window 
related to emergency calls. Depending on your service provider settings, emergency calls may not 
be allowed. In this case, calling an emergency number displays a pop-up dialog. A notification 
message in the Main window may also display. It is not a supported configuration to run many 
Desktop clients at the same time with the same account. 

 

 

2.3 Main Window 

When you start Communicator for the first time, your Contacts list is empty. Use the Search and 
Dial field to find people and add them to your Contacts list. Contacts can also be added manually by 
clicking the Add button. The left pane Call Settings icon and menus are visible. The dial pad is also 
integrated with the Main window history tab. 

Communicator uses tabs for new chat sessions. The Search field allows searching for contacts. The 
table that follows the images describes the key icons used in the Main windows. 

 
Figure Tabbed Main Window 

 
 
 

 

NOTE: If you choose automatic sign in, you are automatically signed in and taken to the 
Main window upon subsequent Communicator launches. Otherwise, you are presented 
with the Sign In screen when launching the application. In the Main window, your default 
tab when signing in depends on the Masergy configuration; otherwise, Communicator 
remembers the tab you were on at sign out and opens that same tab at sign in. 

 

NOTE: It is possible to run several Communicator instances at the same time, but 
headphone connectors and Outlook integration may not work as expected. 
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Icon Usage 

 
My Information – View and update your information, for example, 
your presence, avatar, and location. 

 
Contacts – View your contacts. 

 
My Room – This is your permanent communication room. 
Participants can dial in to your audio bridge. 

 
Call History – View previous calls. 

 
Chat History – View previous chats. 

 
Dial Pad – Make calls (it is integrated with the Main window). 

 
Web Button – Provides web content inside the Main window or 
browser. 

 
Preferences – Use for quick access to preferences and Call Settings 
such as Call Forwarding. 

 Chat – Start an instant message conversation with a selected contact. 

 Call – Make an IP audio call to a selected contact. 

 
Call from Phone – Make a Click To Dial call from your desk phone (or 
secondary device). 

 Video Call – Make a video call to a selected client (VoIP). 

 Share – Share either the whole screen or an individual application. 

 Menu – Open Communications options. 

 Add – Add a contact, group, or conference. 
 

My Information 
 Click the avatar to update your status or location and enter free text. 

 

Presence 
You can set your presence to one status indicated in the following table. 

 

Icon What it means 

 
Automatic presence: This is the Available status where automated presence 
statuses such as Busy In-call override the Available status. Requires newer 
presence server (aggregated presence) to show. 

 
The green presence icon indicates that the user is online and ready for 
communication. This status is used until you change it and automated 
presence statuses such as In Call do not override. 
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Icon What it means 

 
The yellow presence icon indicates that the user is online but has been idle or 
away from their computer for more than ten minutes. 

 
The red presence icon indicates that the user is busy and does not want to be 
disturbed. 

 
The grey presence icon indicates that the user is offline and the only available 
contact method is calling or leaving a chat message. 

 
This icon indicates that the contact is busy on a call. This is an automated 
presence status. 

 
This icon indicates that the contact is busy in a meeting. This is an automated 
presence status. The Busy – In Call status overrides the Busy – In Meeting 
status so this one is only seen if there is a meeting but no call. 

Communicator can automatically update your presence to the following: 

 Busy – In Call 

 Busy – In Meeting (Windows only) 

 Available (desk phone) 

 Available (mobile) 

 Away on mobile 

 Offline and busy in call 
 

Location 
Your location is automatically determined by your public IP address; however, you can manually 
set the text to appear for your location and time zone using the location dialog box. 

 

2.4 Communications View 

After starting communication with one or more contacts, a new tab is displayed for chat. The call 
window is also integrated with the Main window chat tab by default. You can separate a tab on 
to a different Communications window by using the pop-out button in the Main window. From 
this view, you can perform the following actions: 

 Escalate a chat to include audio, video, and desktop sharing 

 End an audio or video call 

 Open the dial pad 

 Mute your microphone 

 Adjust your speaker volume 

 Place a call on hold 

 Transfer a call 

 Toggle between speaker and headset. You must specify different devices for a 
speaker and a headset in Preferences to use this feature. 

If you are using several monitors, Communicator opens the Communications window as well as 
notifications on the same monitor as the Main window. 

Communicator limits the number of active communications to spare resources. The limit is 20 
active communications on Windows and on Mac OS. If the maximum is reached, the main 
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window’s top section warns user with the following message: “The maximum amount of 
communication windows has been reached. Please close some to open new ones.” 

If an incoming call is answered while this warning is shown, the client closes the chat session 
that has the longest time since its last activity. 

 

2.5 Start Chat 

Start a chat tab using one of the following methods: 
 Double-click a contact from the Contacts list or search results. This can be changed to single 

click in preferences by changing to the single-click mode. 
 Right-click one or more contacts from the Contacts list or search results and click the Chat 

menu item. 

 On the Chat History list, double-click a chat entry. 

 In a Communications window, click the Chat button (this does not open a new tab). 

 In the Main window, click the Add button and in the resulting tab click the Chat icon. 
 

2.6 Send File 

In a one-to-one chat, transfer files by clicking the Send File button in the Communications window or 
use the “drag and drop” method so that they are moved to the Communications window. 

 

2.7 Send Email 

Right-click a contact from the Contacts list or search results and select the Email menu option. 
The contact must have an email address defined for this feature. 

 

2.8 Make Audio or Video Call 

Make an audio or video call using one of the following methods: 

 Right-click one or more contacts from the Contacts list or search results and select the Call, 
Call from Phone, or Video menu item. 

 Type the called number in the Search and Dial field and click enter. 

 Hover over the contact list avatar and select one of the audio or video call buttons. 

 Open the dial pad, enter a phone number, and then click the Call, Call from Phone, or Video 
button. 

 On the Call History list, double-click a call entry. 

 In the Communications window, click the Call, Call from Phone, or Video button. 

 When viewing a contact’s profile, click the Call, Call from Phone, or Video button. 
 

 
 

2.9 Share Your Application or Desktop 

Share your desktop by following these steps: 

1) Click the Start Sharing button in the top of the Communications window (if share panel is 
not visible). The Share button is visible by default in My Room also. The share selector 
window opens. 

 

NOTE: If dialing a phone number that requires additional dual-tone multi-frequency 
(DTMF) tones (for example, a conference bridge), you can type the numbers on your 
keyboard while the Communications tab has focus or open the dial pad in the 
Communications tab. 
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2) Select the application to share or the entire screen of a particular display and click the 
Start Sharing button. 

 

 

2.10 Active Communications 

Active communications appear at the top of the Contacts list in the Main window (native Desktop 
only). This area provides an easy view to see the people with whom you are communicating. There 
is no separate call tab but call is shown in the Active Communications area in the Main window 
(where the call can be fully controlled in the Desktop client). It reduces the number of 
Communications windows; however, a separate call window can still be opened using an Active 
Communications menu. The following is also available in this area: 

 Double-click an active communication item to bring this Communications tab to focus if the 
call window is separately shown. If the call window is integrated, you can use the pop-out 
button to show it separately. 

 End a call. 

 Mute the microphone. 

 Place a call on hold. 

 Merge two calls or transfer by dragging and dropping calls onto each other. 

 Transfer a call. 

 Make conference calls. 

 Park and retrieve calls. 

 Set audio device to headset or speaker. For more information, see section 20 Preferences. 

 Conference 

 Call Transfer 

 Call Park 

 Call Pull 

When enabled, you can use these buttons for faster access to services. 

You can right-click the “More” icon of an active Communications item (icon with three dots) for 
additional options while a left-click offers additional call management options for this call as well as 
other options when available. 

 

2.11 My Room 

My Room is an always available and permanent room you can use to chat with anyone that joins. 

If you assign a conference bridge to your profile in Preferences → Credentials, then in your room, 
you and your attendees can click the Call or Video button to have Communicator automatically dial 
in to the conference and enter the appropriate entry codes. Note, if Masergy has auto-provisioning 
enabled, then you cannot edit these details. If Masergy has silent dialing enabled, then you cannot 
hear any DTMF tones when dialing into My Room (the call is made automatically). 

If a conference bridge is not specified, you cannot initiate a call in your room. 

 

NOTE: To share your desktop, you must enter your web collaboration credentials in 
Preferences → Credentials, unless Masergy has automated provisioning in use. For 
more information, see section 20 Preferences. You can participate in desktop sharing 
sessions by another user even without having your own sharing credentials. 
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You can invite others to your room by dragging and dropping them from the Contacts list into the 
My Room tab. You can also use the right-click menu on the My Room icon in the top-right corner of 
the Main window or the My Room information area to copy an invitation link for guest users 
(people without Communicator). They can then click the link and join the meeting through a web 
browser. Guest users must be separately accepted for each session. 

Contacts join your room by right-clicking your name on their contact list and selecting Join Room or 
by an invitation you sent. 

Email My Room Invitation menu results in working links for guest users and Communicator users. 
Communicator users are recommended to use “Copy Guest Link” invitation links; however, the 
btbc link part links when enabled by Masergy may not work in all applications as they were 
originally intended for Outlook. 

You can also export the attendee list using the related participant menu available via the options 
icon (three dots). In My Room calls, the owner can also see active speaker info with the 
Mute/Unmute icon. My Room can also be moderated, for more information on moderation, see 
section 6.15 Moderator Controls. 

My Room calls cannot be conferenced or transferred. 

In Preferences → General tab, you can select to use an external Webex Meetings app for your My 
Room sessions. In that case, there is no synchronization of events between Communicator and 
Webex Meetings. 

 

2.11.1 Select Audio Devices 

If you have multiple audio devices available for your microphone or speakers, select the preferred 
audio device before starting a call. 

Windows 
1) Click the Communicator logo in the Main window title bar. 

2) Select Preferences. 

3) Select Audio. 

4) Set a playback device (speakers). 

5) Set a recording device (microphone). 

6) Click OK. 
 

Mac OS 
1) Select Communicator from the main menu. 

2) Select Preferences. 

3) Select Audio. 

4) Set a playback device (speakers). 

5) Set a recording device (microphone). 

6) Click OK. 

If “Use default” is selected, then Communicator uses the default device set in the operating 
system preferences. For Windows, if “Default Communication Device” is defined, it is selected 
over the “Default Device”. If you are using headsets, you can also select a separate device than 
the headset for alerting incoming calls. 

Note that on Mac OS, it is recommended to disable “Use ambient noise reduction” in System 
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Preferences to reduce echo. For more information on USB headset support and settings details, 
see section 6.17 Headset Support. 

 

3 Contacts 
Contacts are the people with whom you communicate and, in most cases; you see their presence 
and share your presence with them. There are three types of contacts: 

 Contacts – Actual people with whom you communicate. 

 Conferences – Audio or video conference bridges that you use to communicate with others. 
Silent dialing into the bridge also applies to these contacts if enabled by Masergy. 
Conference contacts are regular contacts and are added just like regular contacts. 

 Groups – Containers of contacts and/or conferences. 

There is no hard-coded limit on the number of contacts. The more contacts are added the more 
memory and processing is needed. The more contacts are added, the more difficult it is to find 
people without searching. Live search can be used instead of a very large local contact list while 
keeping memory and processing requirements to a minimum. 

Contacts are synchronized with Cisco BroadWorks server data when you: 

 Enter the call history view for the contacts that are in the call history. 

 Make a call to someone who has not been synced. 

 Manually sync the contact in the contact card when that feature is enabled. 

 With automatic contact sync mode, the contact card must be opened for data 
synchronizing to occur. Note that if IM&P is enabled and the contact has no XMPP JID, 
synchronizing with the server is not done. 

 Chat message history synchronization is enabled. 

 The contact card is synchronized with Cisco BroadWorks when the contact is added via 
Cisco BroadWorks directory search. 

 

3.1 Add 

When you sign in for the first time, there are no contacts on your contact list. Add a new contact at 
any time by selecting the Add Contact item from the menu or choose the Add button from the Main 
window (+ icon). In the resulting tab, you can select to add a contact, group, or other items. 

In the Add Contact tab, enter the contact’s information and then click Save. By default, your 
presence information is always shared with a new contact if an Extensible Messaging and Presence 
Protocol (XMPP) address is provided. 

When receiving a buddy request, there are two buttons for accepting and rejecting the request. 
Dismissing the buddy request window only ignores the request for the duration of the login 
session. It reappears after the next login. 

However, you can always share your presence information later by selecting Subscribe on the right-
click menu for a specific contact in the contact / directory list. Note that the contact must accept 
your subscription request for you to establish the presence relationship successfully. 

The newly added contact appears on your contact list. 

Add a conference contact by clicking the same button you did for Add Contact. A conference 
contact is a special contact used for conference bridges to avoid remembering PIN codes and 
conference number, for example, recurring conferences. Just create a contact for the weekly 
conference, add a conference bridge number and PIN, and join the conference just by right-clicking 
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the contact or choosing it and clicking the Call button. 

Choose the Add Group menu option to add a new group to the contact list. 
 

3.2 Edit 

Edit a contact by selecting the contact first. After you select the contact, right-click anywhere in the 
area of the selected contact and a menu of options appears which allows you to either view or edit 
the contact profile. In View mode, click the Edit button to go to Edit mode. This base principle is 
the same for normal contacts, conference contacts, and groups. Note that depending on your 
Masergy settings all or no contact card fields may be editable. 

 Unsubscribe removes the presence relationship between you and that contact. This means 
you do not see the contact’s presence information and your contact does not see yours. To 
re-establish the presence relationship, select Subscribe. An unsubscribed contact remains on 
the contact list and is always shown without an icon. Any contact that is not presence-enabled 
is shown in the same way. 

 Delete contact removes the contact from your contact list. 

 View Profile opens the Contact Information dialog box where you can add, edit, or remove 
information. This works for both normal and conference contacts. 

 For groups, choose the Edit menu option to rename a group. Once done with all changes, click 
the Save button. 

3.3 Filters 

You can filter contacts in two ways: 

 Use the filter field to search by contact name. The contact list is filtered in real time as you 
type. 

 Alternatively, use the filter menus available by right-clicking the Contacts icon in the left 
pane to display only specific types of contacts such online contacts. You can also sort 
contacts based on first or last name or choose whether to display the contact’s avatar and 
availability status in the contact list. 

Favorite filtering works slightly differently in the current release: 

 When you make a contact your favorite, the favorite group shows on top of the contact list and 
cannot be hidden. 

 When you delete all your favorite contacts, the favorite group does not show anywhere. 

 When you have even one favorite marked, you see the group. 

4 Presence 
For each contact you have subscribed to, you can see their presence. Similarly, your contacts can see your 
presence on their contact list. 

Presence means that your friends are able to see whether you are available to communicate, for example, “I’m 
busy” or “I’m available”. 

 

Icon What it means 

 
Automatic presence: This is the Available status where automated presence statuses 
such as In-call override the Available status. Requires newer presence server to show. 

 
The green presence icon indicates that the user is online and ready for 
communication. This status is used until you change it and automated presence 
statuses such as In Call do not override. 
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Icon What it means 

 
The yellow presence icon indicates that the user is online but has been idle or away 
from their computer for more than ten minutes. 

 
The red presence icon indicates that the user is busy and does not want to be 
disturbed. 

 
The grey presence icon indicates that the user is offline and the only available contact 
method is calling or chatting. 

 
The question mark indicates that a subscription is pending and the contact has not yet 
approved sharing their presence. 

 
This icon indicates that the contact is busy due to a call. This is an automated presence 
status. 

 

This icon indicates that the contact is busy due to a meeting. This is an automated 
presence status. The Busy – In Call status overrides the Busy – In Meeting status so 
this one is only seen if there is a meeting but no call. 

 This icon indicates that the contact is only available on mobile Communicator. 

 
This icon indicates that the contact is only available on a compatible desktop phone, 
and not Communicator. 

 This icon indicates that only the mobile client is online and in the away status. 

 
This icon indicates that the user is in a call but is not logged in to XMPP (presence and 
chat). 

 

The avatar in this version is not completely in real time. The avatars are retrieved at login, when the 
contact is added, and when the contact comes online. Double-click the avatar to change your 
avatar. A File Explorer view opens. 

If you see an error message at the top of the Main window “XMPP Unavailable”, it means that the 
XMPP connectivity has been lost for chat and presence; however, you can still make calls. You 
should contact Masergy support if the messages persists longer than 15minutes. 

Have the Outlook calendar automatically change your presence to Busy – In Meeting by enabling 
this in the Preferences → General tab (native Desktop only). 

The presence update is only triggered by appointments and meetings that are in the Show me as 
busy state. 

The XMPP address of a contact cannot be changed. Instead, you must delete the old contact 
and create a new one. 

Location in presence is done based on the IP address that the machine is using on Windows. The IP 
address is mapped to a physical location. Cisco (formerly BroadSoft) is working with the mapping 
provider to improve the accuracy of the location. On Mac OS, the operating system location is 
utilized. You will be prompted to accept location usage. Change the location manually by clicking the 
avatar (if presence controls are not already expanded) and then the location icon to go to the 
manual location and change the view. 

Snapshot of presence status is also available in search results and Communications window for 
contacts who are not buddies. This presence status is not updated after the search is done or 
after the communication session is set up. 

When Communicator desktop is used together with Communicator Connect, offline presence usage 
on desktop may cause inconsistent presence status to be shown for mobile. 
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5 Chat 
5.1 Chat View 

When you initiate a chat, the Chat tab inside the Main window opens. Chatting with a contact is 
possible only when you are both online. If your contact initiates a chat, you see a pop-up 
notification in the bottom right-hand corner of the screen. If you close the Chat tab and open it 
again, sent chat messages are shown in the tab as chat history.  

When the chat opens, you see the contact’s information at the top of the screen. 

In the text field, you can add a smiley emoticon. Smiley emoticons can also be added by manually 
entering the corresponding characters that represent that particular emoticon. You can send text by 
pressing ENTER. 

The full set of Emojis is also supported and they are rendered as ordinary emoticons when received. 
Spell checking in US English is also supported and can be disabled in Preferences. For 
troubleshooting tips, see section 28 Troubleshooting. 

To enter a line break in the text field, you can use the following key commands: 

 CTRL+ENTER (command+enter on Mac) 

 SHIFT+ENTER 

 ALT+ENTER 

Use either one of the short commands, CTRL+C or CTRL+V, or right-click the selection for a menu 
to copy or paste the text to or from the Chat tab. 

It is also possible to chat with users in other domains. Cisco BroadCloud also supports Google 
federation. Group chat is not supported in Google federation, so the group chat option with these 
contacts is shown in grey. 

All sent and received chats are stored locally in the chat history and an optional message history 
feature provides multi-device enhancements so that messages sent or received in other own devices 
would also be shown. 

The older chat messages may be automatically deleted. In this case, the history links in the top area 
of the Chat view are automatically adjusted. 

 

5.2 File Transfer 

File transfer functionality is only accessible through the Chat tab. 

1) To open the File Selection dialog box, click the Send File button located to the side of the text 
field. 

2) From the dialog, select the file to be sent, and then click Open. You can also drag and 
drop a file into the Chat tab. 

3) Once the file offer is issued and during its transfer, you can cancel the transfer (at any time) 
by clicking Cancel. 

4) Accept an incoming file transfer by clicking the Accept button. 

5) Reject the file transfer offer by clicking the Decline button. 

After the file transfer has completed, the received files can be opened or viewed in the file 
manager by using the File received, click to open, and Show in folder links. 

In error situations, partially received files are not deleted automatically. 
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5.3 Group Chat 

Start a group chat by “multi-selecting” and right-clicking the Main window contact list or by 
expanding a 1-1 chat into a group chat using drag and drop or by having a multi-party call. More 
people can be added later to the chat by drag and drop. Only the owner can add more participants.  

A group chat works the same way as a one-to-one chat in a tabbed view. All messages from anyone 
are sent to everyone else. All contacts need to be online to be able to participate in a group chat. 
You cannot invite an offline contact or a contact that is not on a device that supports group chat. 
This does not affect the group chat in any way. 

A group chat history is saved both in My Room and in ad hoc chat rooms and is available to view 
later in the Messages tab of the Main window. 

In the text field, the contacts’ names appear in different colors to easily distinguish between 
who is writing. 

Only the newest chat room messages are stored on the server. One-to-one chat messages are only 
saved locally. When the optional Message History feature that is enabled Masergy, messages sent 
from your other devices are also shown. 

Deleting a chat room is not supported. 

Chat rooms can be moderated by the owner. Use the right-click menu options to remove a 
participant from your chat room. If needed, the removed participant can join later. The removal 
also applies to desktop share sessions. 

Typing notifications are not supported in group chats. 

Communicator support for receiving group messages sent from Communicator Connect and 
support for also initiating Connect group messaging sessions. New Connect group message threads 
are created using the New button (+ icon in the Main window) and in the opened view selecting 
chat discussion participants and then sending at least one message to the selected participants. 
Alternatively, you can multi-select contacts and start a Connect group messaging session in that 
way. 

6 Audio and Video Calls 
The following table describes additional Communications window icons and explains what you can 
do with them, for voice and video calls. 

 

Icon What you can do 

 
Add or remove video from the call. 

 
Mute your microphone by clicking the mute icon. 

 

Put the call on hold. Note that if you hold the call, the other party 
cannot “unhold”. This freezes a video call to the last frame of the 
video feed. In both voice and video calls, this is communicated to all 
parties by a notification appearing in the middle of the screen. 

 
Use this icon to access the Call Options menu. In the Call Options menu, 
you can find different actions to use for a call. 

 
 

In the Options menu, there are the following options: 

 Transfer a call to a third party. 
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 Put the call on hold. Note that if you hold the call, the other party cannot “unhold”. This 
freezes a video call to the last frame of the video feed. In both voice and video calls, this is 
communicated to all parties by a notification appearing in the middle of the screen. 

 Adjust the volume bar to adjust the volume. Dragging it all the way to the left mutes your 
speakers. 

 Enter additional digits using the dial pad at any time during the call (for example, to insert 
a conference number). The dial pad is not movable. 

 Toggle between the audio headset and speakers. You must specify a different device for a 
headset and a speaker in Preferences to be able to use this feature. 

 Add participants to the call. 

As an alternative, in general, available Feature Access Codes (FACs) for call management work 
during calls, for instance *55 for direct transfer to voice mail, but the ongoing call must be put on 
hold and a new call must be made to the FAC number. Using DTMF for the same purpose does not 
work. 

When establishing a call to a contact, you can choose several ways to call. Right-click the contact 
you want to call and select the Call menu item. You can choose the number to call from a right-
click menu. There can be several phone numbers available in the menu. The work phone is the 
default and top-most number is followed by mobile and other numbers. This also applies to the 
transfer and conference windows. However, in certain cases, the transfer/conference default 
number can differ from other call options in other menus. 

The default call type can also be selected using accessibility menus (Calls → Dialing service). This 
controls the default call type when using call buttons. 

Dial a number in the combined Search and Dial field to make a call (native Desktop only). Once 
you type your numbers, Communicator searches for contacts on both the local contact list and 
the enterprise directory. 

You can also call circuit-switched network numbers such as Global System for Mobile 
Communications (GSM); however, this is supported on Masergy’s network and there is no technical 
limitation. 

Choose your video size from the Preferences and the Video tab. Your selection is used by default for 
future video calls. The available sizes are automatically presented based on your camera. 

You cannot have two simultaneous calls with the same person. 

Communicator does not add video to an audio call without end-user consent. This also applies to 
blind video call transfer cases where audio-only music on hold is used; this may result in the 
transferred call being reduced to audio. 

You can also see a secure call icon when an encrypted call is taking place. 
 

 
 

6.1 Call From Computer 

Select a contact from your contact list to start communication and click the desired 
communication button. To communicate with someone who is not on your contact list, type a 
phone number in the Dial pad view. 

 
 

 

NOTE: There is sleep prevention during calls. 
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6.2 Call From Phone 

The second option to communicate in the row of communication buttons is the Call from Phone. 
When you click this button, the desk phone instantly starts ringing and the call is established from 
your desk phone. The Masergy configuration will provide other shared devices to also ring. 

For remote calls initiated using Communicator, you can also have mid-call controls such as 
hold/resume, transfer, and add participant. 

Automatic Busy – In Call presence also works with the Call from Phone feature. 

It is also possible to control calls initiated without Communicator in the Active Communications 
view. The same mid-call controls are also available in this case. In case of an incoming call, the 
actual answering action must happen with the other device. 

6.3 Answer Call 

When someone is calling you, you see a pop-up notification on your screen. You can choose to 
answer, silence the incoming call, and then open a chat session with the caller, reject the call, or 
silence the incoming call by closing the pop-up notification window. If you silence the call, the 
ringtone is silenced but the caller does not see anything on their end. You can answer or reject the 
call after silencing it only if you have chosen the chat option. If you close the incoming call pop-up 
notification to silence an incoming call, then you do not have an option to answer or reject it any 
more. When choosing the chat option, chat is only enabled after the call has been answered or 
rejected. 

If you reject the call, it causes the line to sound busy at the caller’s end and they know that you rejected 
the call. 

When someone is calling you with a video, you see the same pop-up notification; however, the 
options are answer with video, answer as voice only, silence and chat, reject, or silence (by 
closing the pop-up window). If you decide to answer as voice only, the call is voice only. 

 

6.4 Priority Alert 

Priority alerting/distinctive ringing allows you to provision call criteria in a web portal to provide a 
distinctive ring or call waiting alert tone when a call is received that meets the criteria. The criteria 
may include information such as the calling line identification, time of day, day of week, and so on. 

 

6.5 Contact Name Lookup for Incoming Calls 

Communicator performs a local contact search for incoming calls. If the number matches one of 
the contacts on the Communicator contact list, the name is shown on the incoming call screen 
along with the alert. Both the display name and phone number are shown when available. 

If there is no match to a local contact, Communicator looks for a match in the Telephony Directory 
and other available directories, and if a match is found, the available information is shown for the 
incoming call. If there is no match in the Telephony Directory, the display name is taken from the 
available information in the incoming call. 

Whenever you retrieve your call logs/history, Communicator does a lookup in the local contacts and 
populates the name if a match is found. 

 

6.6 Missed Call or Communication 

When you have one or more missed calls or other types of communications, there is a notification 
on the left-hand side of the navigation pane in the Main window. Clicking the icon takes you to the 
missed communication in the Communications History view. 
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6.7 Full Screen in Video Call 

Full screen mode can be activated by clicking the Full Screen button or by double-clicking anywhere 
on a video. 

Exiting full screen mode is done by pressing the Esc key (on both Windows and Mac OS) or by 
double-clicking the window. Exiting full screen makes the video call go back to its original state 
(even if there was resizing of the window previously before going full screen). 

In a full-size window, you can see a similar Options menu at the top. It has the same functionality as 
it does in the normal view. When you move the mouse, the top bar and lower communication 
buttons appear on top of the video. 

6.8 Multiparty Sessions 

You can have many participants in a call, either in a My Room or in an ad hoc multiparty call (native 
Desktop only). Add more participants by dragging and dropping them on to the Communications 
tab or by selecting the Conference menu item via the Communications tab menu button. By 
choosing the menu item, you can also add participants with just a telephone number. Starting with 
Release 22.4.0, ad hoc multiparty calling is slightly different in that each call party must be 
separately merged onto the call to be able to terminate failing calls to, for example, voice mail. 

In contrast to using My Room, which uses your permanent chat and collaboration rooms and 
conference bridge, you can start ad hoc multiparty sessions by either selecting multiple contacts on 
the contact list and starting a chat, by calling them, or by expanding a one-to-one session into a 
multiparty session by dragging and dropping a contact into the Communications window. In an ad 
hoc session, the room used is a temporary one that is deleted once the session ends (that is, when 
the last participant leaves). Voice conferencing does not use a bridge but instead uses the 
BroadWorks N-Way Calling supplementary service in a sequential fashion. Communicator dials out 
to all participants and takes everyone off hold after the last attendee answers. 

In newer deployments with the Video Server (UVS), the ad hoc room created for the session has a 
limited lifetime and becomes inactive when idle for too long. In this case, participants are able to 
rejoin the ad hoc session if they drop out for some reason. A consequence of this is that, in ad hoc 
group calls, participants who are no longer in the call are still visible in the participant list. 

If the XMPP service is not available, then ad hoc multiparty calls are not available. 
 

6.9 Call Waiting 

You can have one active call at any one time if you receive a new incoming call and accept it. The 
existing call is put on hold and you can change between these two calls by using the Hold and 
Unhold buttons. 

If Call Waiting is in the ringing state then new incoming calls are rejected. 
 

6.10 Call Transfer 

Blind call transfer is available in the Communications window; choose the Transfer Call menu item 
to transfer the call to someone else (native Desktop only). Attended call transfer is also available in 
the same window, first call someone to check if the called party can take the incoming call and then 
transfer the incoming call to the desired called party. You can also search for the transferred-to 
party. 

 

6.11 Message Waiting Indication and Visual Voice Mail 

Masergy provides for Visual Voice Mail and Message Waiting Indication (MWI) view in your client. 

The MWI service allows you to receive a notification for a waiting voice mail. By clicking on the 
message icon in the upper part of the Main window, Communicator calls the predefined mailbox 
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number to allow the user to listen to the voice mail.  

It is also possible to call voice mail from the dialer by long pressing the “1” icon in the dialer. 

When visual voice mail is enabled, showing visual voice mails. Click on individual mails to listen to 
them. The current design is that listening to the visual voice mail or marking it as read decreases the 
unread messages badge while just doing a single click does not. Visual voice mail view also indicates 
if the message is urgent or confidential. 

In this current release, refreshing the voice mail view is also done when opening the voice mail view. 
This is in addition to the currently supported usage of the voice mail refresh at login and 24 hours 
after the last usage of the API if you are still logged in. 

Missed calls are indicated by an icon in the Main window. Missed video and audio calls are 
indicated with a different icon. Note that the MWI icon is in the same place when it indicates a 
new voice mail. 

Visual voice mail is supported. You can see all voice mails in a list and play them inside the Main 
window. 

The following settings are needed on Masergy Administration portal to have visual voice mail: 

 Voice messaging enabled 

 “When message arrives, use unified messaging” option enabled 

 “Use Phone Message Waiting Indicator” option enabled Auto-deleted voice mails are 

cleaned once a day. 

The voice mail counts in voice portal and Communicator are slightly different. Voice portal 
messages can be either “New” or “Saved” whereas Communicator messages are either “New” or 
“Viewed”. “Saved” in voice portal is the same state as “Viewed” in Communicator. When a 
message is clicked in Communicator, it is automatically set to “Viewed” status, which is different in 
the voice portal where messages can be skipped via DTMF to keep them in the “New” status. 

 
6.12 Call Park and Retrieve 

Call Park is particularly suited for shared environments where one person can answer the call, park 
it, do something else for a while and continue the call from another device or let somebody else 
continue the call (supported on native Desktop only). 

Transfer an ongoing VoIP call to a Call Park server and then retrieve it when needed. An ongoing 
call can be parked against your own number or another number (an extension). Call Retrieval 
works in the same way, the parked call can be retrieved from your own number (an extension) or 
another number (an extension) to provide flexibility for who is picking up the parked call. 

A parked call is visible on your desktop in the Active Communications area so that you can easily 
retrieve it, but only for the duration of the BroadWorks Call Park announcement. After the 
announcement is over, the parked call disappears from the Active Communications area (since the 
triggering call is disconnected). After the call disappears from the Active Communications area, the 
user must remember the extension to which the call has been parked to retrieve it using the Main 
window menu (or feature access code), unless the call was parked to the one’s “own” extension. If 
the call is not retrieved after a certain time, then the server calls the parking user. 

6.13 Call Pull 

Call Pull allows you to pull an ongoing call from one of your devices to another one where the Call 
Pull feature is used (native Desktop only). Call Pull can also be used with FACs, in this case, *11. 
User interface support has been added to the Desktop so that an end user does not have to 
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remember FACs. Release 22.4.0 added support for the Call Pull button for Xsi calls as well. 
 

6.14 Call Recording Controls 

You can use call recording controls in this release (native Desktop only). Call recording can be 
initiated when a call starts or dynamically during a call (and start, stop, pause controls may be 
available). Additionally, there is an audio indication that call recording is ongoing as well as a visual 
indication. Feature Access Codes can also be used to control call recording when enabled in the 
configuration. 

Recorded calls are accessed outside of Communicator; that is, you cannot view them using the 
client. 

Masergy call recording behavior is one of the following (this cannot be controlled in the client 
but in the self-provisioning portal): 
 Always – recording indication (icon) in the Communications window as well as the Active 

Communications UI. 

 Always with pause/resume – recording indication (icon) in the Communications window 
as well as in the Active Communications UI (only pause/resume menus available). 

 On demand – recording indication (icon) in the Communications window as well as the Active 
Communications UI (no stop menu available, only start and pause/resume). After a call is 
established, call recording starts on the server. If the user presses the Start Recording button 
during the call, the call recording is stored and the server keeps the recording of the whole 
call regardless of when the recording was started (except for pauses). Otherwise, if no start 
recording is initiated from the user, the call recording is deleted from the server. 

 On demand with user-initiated start – recording indication (icon) in the Communications 
window as well as the Active Communications UI (menu options available for start, stop, 
and pause). Call recording can be initiated at any time and several times during a call. There 
are separate call recordings for each call recording startup. 

 Never – no indicators or menu options present. 

Pause/resume audio indication depends on your Masergy settings. It is recommended to log back 
in after changing the call recording mode in the self- provisioning portal. 

 

6.15 Moderator Controls 

You can control the functionality available to participants if you are the owner of the session 
in My Room. You can do the following: 

 Dismiss one or more participants. This ends all sessions (group chat, audio, video, and 
share) when the participant is using Communicator for Desktop. 

 Mute one or more participants. 

 Lock or unlock the room (when locked, no additional participants can join). 

 See active talker indication (room owner only). 

 See full audio participant list. 

 Choose who can join without separate authorization (moderated My Room): 

 Require only guests to request access 

 Require everyone to request access 

 Allow everyone to join automatically 
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To invoke the features, you can use the right-click menus or you can click on the moderator 
control icons of a participant. Note that most features are not available via icons. To dismiss or 
mute all participants or lock the room, use the right-click menus available for your own icon at 
the top of the participant list. 

If you are not the owner, you can only see the XMPP (chat) participant list or the full participant list 
along with mobile participants (depending on your Masergy settings). 

 

6.16 Forced Logout 

Depending on your Masergy settings, you may see a pop-up saying that you have been logged out 
due to another instance of the client logging in (native Desktop only). 
This feature allows BroadWorks to track similar online client instances and only allow one of them to 
be online at the same time. When BroadWorks notifies the client to log out, all connections are 
terminated and client returns to the login window. 

 

6.17 Headset Support 

You can control incoming and ongoing calls from a compatible headset. The feature set supported 
is answer/hang up as well as mute/unmute. Volume control operations are not reflected in the 
Communicator UI. The following is a list of tested example devices, although other devices should 
also work: 

 Plantronics Voyager Edge UC 

 Plantronics Savi 700 series 

 Plantronics Blackwire C3xx, C4xx, C5xx, and C7xx 

 Plantronics Calisto 620 

 Plantronics Voyager Legend UC 

 Logitech H570e Mono 

 Logitech BCC950 

 Logitech Conference Cam Connect 

 Jabra Biz 2300/2400 

 Jabra Speak 510 

 Jabra Pro 930 (wireless) 

 Sennheiser SC 230/260 

 Sennheiser SP 20 

 Sennheiser MB Pro1 UC 

Headsets typically use an add-in of some kind to communicate with the rest of the client while calls 
are made. Currently, installed add-ins are visible from the Preferences Add-ins tab. 

In addition to the standard human interface device (HID) Add-in developed by Cisco (formerly 
BroadSoft), headset vendors can develop their own add-ins that can replace the Cisco (formerly 
BroadSoft) Standard HID Add-in for all devices. Some of these add-ins (for example, Jabra or 
Sennheiser) cannot be used at the same time with the standard HID Add-in so either the Cisco 
(formerly BroadSoft) Standard HID Add-in or the vendor-specific add-in must be disabled via 
Preferences in the Communicator client if one of the two is not automatically disconnected. Add-in 
installers should copy the required add-in dlls into the Communicator add- in folder so they become 
visible in Preferences. 
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These vendor-specific add-ins are typically installed during new headset installation; however, the 
Cisco (formerly BroadSoft) Standard HID Add-in should remain in the preferences list. If for some 
reason it has disappeared, adding the respective .dll file back to the add-in folder should make it 
visible again in the Preferences. If later on you want to change to another headset, the vendor-
specific add-in could be disabled from Preferences to again use the standard HID or some other new 
add-in by another headset provider. Re-login is necessary to take the new add-in into use. 

Some USB headsets may have additional functionality offered by the vendor-specific add- in such as 
answering the call directly when taking the USB headset off dock. See the USB headset 
documentation for details of such functionality. 

If you are using many different headsets, the Cisco (formerly BroadSoft) Standard HID Add-in 
offers a default add-in that can always be used. 

The following is the default add-in folder location: 

 Windows 7/Windows 8/8.1/10: C:\Program Files (x86)\Masergy Communications 
Inc\Communicator\connectors 

Uninstallation does not remove add-in DLLs. In general, the following steps could be followed 
with third-party add-in DLLs. 

1) Make sure that both Communicator and the third-party add-in are installed. 

2) Go to Communicator → Preferences → Extensions. 

3) Enable your add-in of choice, either USB Device Add-in by Cisco (formerly BroadSoft) or a USB 
headset vendor-specific one. 

4) Restart Communicator to take the changes into use. 

If you want to use several devices, consider the following rules for audio device auto- selection: 

1) Communicator has a list of five last selected audio devices per each audio device selection 
control in Communicator Preferences. Each audio device can exist in a list once at most, 
that is, if a device becomes selected again before four other devices have been selected, a 
duplicate item will not be created for the device in the list but the existing item will be 
moved to the beginning of the list. The order of items in the list is significant in the sense 
that it defines the order in which other devices become selected when a device is 
disconnected. In a laptop for instance, the native microphone and speaker are one 
applicable device for the list of five devices. A device can only end up to the list of five 
devices above during disconnection. 

2) The “Use default” item is never put on the list as it will serve as a fallback if none of the five 
devices on the list are available. The end user has a chance to specify the default device and 
the default communications device. 

3) When a device is reconnected, it becomes automatically selected only if it was selected 
when it was disconnected. Disconnecting devices that are currently not selected does not 
have any special behavior. Information on devices disconnected while selected is not 
persisted in the database, that is, this behavior does not work over different user sessions. 

In a case with two devices involved (for example, a headset and the native speaker/microphone) 
and end users sometimes selects both, the ability to automatically fluctuate between built-in 
devices and third-party headset when plugging it in should be obtainable by using the OS default 
device selection for the in-built devices and then plugging in the headset. 

 

6.18 Team Telephony (Busy Lamp Field) 

Team Telephony is comprised of a Team Telephony window showing the predefined team 



 

Page | 24  

members and their related call states (native Desktop only). For a ringing call, the only action is to 
pick it up. 

Each Team Telephony member can have four call states: available, busy in call, ringing, and offline. 
The status for a Team Telephony member is shown in the Team Telephony window. When a line is 
ringing, you can see the caller ID in the respective lines tooltip if configured by Masergy. All team 
members can see the full list of team members in the Team Telephony window. A double-click on 
the team member performs the default action towards the contact. You can drag and drop people 
from the contact list to the Team Telephony window or vice versa to transfer or conference calls. 

 

6.19 Executive-Assistant 

The Executive-Assistant service allows an assistant to operate on behalf of an executive to screen 
calls, answer calls, and place calls as the “executive” (the caller ID is the one of the executive) 
(native Desktop only). The provisioning of the executive and assistant roles takes place on the 
server side and cannot be modified on the client. 

One assistant can have many executives and it is possible to: 
 Select the desired role when making a call using a pull-down menu in the Main window. 

 Answer an incoming call on behalf of an executive and then push the call to the 
executive. The incoming call is presented as a call to the executive. In addition, all the 
usual call management options are available. 

 See that an incoming call is actually for the executive. 

The caller ID format is dependent on your Masergy settings and cannot be changed on the 
client side. 

 

6.20 Presence Rules and Silent Alerting 

End-user can combine call processing with presence statuses (native Desktop only). For instance, the 
“Busy” status can be combined with Call Forwarding so that when the “Busy” presence status is 
used, calls are forwarded. It does not matter how the presence status is invoked, via automation or 
manually. 

All presence statuses can have presence rules: 

 Available 

 Busy 

 Away 

 Offline 

The following Masergy call processing services can be used: 

 Silent alerting 

 Call forwarding to number 

 No rules 

If presence rules are used, all your client devices should have this service enabled to avoid side 
effects. Silent Alerting is supported whenever an incoming call has that feature enabled. Silent 
alerting can only be enabled via presence rules in Communicator but various settings can also be 
altered via web provisioning. 

 

6.21 Call Center Agent Login 

End-user can also log in to your call center queues if you are a call center agent (native Desktop 
only). You can do the following: 
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 View your call queues. 

 Join your call queues. 

 Set the Automatic Call Distribution (ACD) status so that you get incoming call center calls. 
However, this is dependent on your license settings. 

With suitable ACD status such as “Available”, incoming calls to the queue are routed to your client. 
With “Unavailable” ACD status, the BroadWorks Do Not Disturb (DND) state can also be selected or 
“Personal Call”. Each ACD status indicates with text if you are to receive incoming call center calls. 

Dynamic ACD status updates are not supported if the ACD status is changed somewhere else. 

6.22 Remote Control Event Package 

Remote Control allows you to answer a call, put it on hold from a receptionist, or call center client 
while the results are seen in your Communicator Desktop client. Answer and hold/resume buttons 
are visible in Receptionist/thin client to perform call management operations. 

 

7 Application or Desktop Share 
To share your desktop or individual application: 

1) In the Communications tab, click the Start Share button. This does not yet start the 
“share”. 

2) Select either to share your entire display or one of your open applications and click 
Start Sharing. 

The share widget appears to let you control share settings such as Preview that shows you 
what participants are seeing and Pause that pauses sharing. 

3) To stop sharing, click the Stop icon. While sharing, all other communications mechanisms 
are also available except for video calling and file transfer. Participants cannot hide a share 
without closing the Communications window. Video call is also available while sharing. 

Desktop sharing works the same way in both My Room and in ad hoc sessions. For participants 
without Communicator, use the separate Desktop Share Invitation link, if available, by right-clicking 
the My Room button. Share selector is not dynamically updated while the selector is open and 
minimized applications are not available in the list of applications to share. 

As a participant, you can also zoom in and out during the share. When you are the share owner, 
incoming message toasters are suppressed during share, but the missed message badge is 
incremented and the incoming message sound is played when enabled. 

If you are first in a video call and then start share, your own video is not shown due to limited 
space available, but you can make it visible using the Main window menu in the bottom right-
hand corner by selecting “Show Own Video”. 

If you are using dual monitors, you can choose which monitor to share. You can check the 
primary monitor in the operating system settings. 

You can also remove desktop share participants. They are also removed from the group chat at 
the same time. If needed, the removed participants can join later. 

In addition, participants will be able to share by clicking on the Share button; however, the room 
owner can prevent this at any time. Only one person can share at any one time in a session. Only 
one share at a time is supported if you have sessions with many users at the same time. Share 
passing is only supported in My Room. 

Participants do not have to take any action to accept the share invitation. It is automatically 
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accepted. The same also applies to share passing. That is, the owner does not have to take action 
for the participant to start sharing. 

When video and share are used at the same time, the different views cannot be resized. Instead, 
the primary view can be selected from the bottom of the window via thumbnails. 

In deployments using the older web collaboration solution, clicking the Share button opens an 
external browser window where share can be viewed. 

8 My Room 
My Room is started by clicking on the My Room icon on the top right-hand side of the Main 
window. My Room is started automatically using your permanent chat room. Add more participants 
by dragging and dropping them into the Communications tab or the Conference menu. Otherwise, 
they can join your room by right-clicking your name on their contact list and choosing the Join 
Room menu option. Once people have joined the chat room, they can click on the Call button of 
that window to join the conference. The room owner can also share their desktop. 

To use the full functionality of My Room (desktop sharing, conferencing, and chat combined), 
you may have to manually enter your desktop sharing credentials, your conferencing 
number, and the moderator PIN in the Preferences → Credentials window. This depends on 
whether or not you are using the Meet Me bridge or not. 

In addition to the owner of the room, participants can also share the desktop but only the owner 
can add more participants. This applies to both My Room and ad hoc sessions. 

1) To see a Context menu, right-click the Options icon (three dots) on the right-hand side of 
the My Room tab for Room Info. 

2) To modify credentials and conference bridge information, select Configure to go to the 
preferences. If Masergy has automatic provisioning enabled, then this menu item is not 
present. 

3) Select Copy Guest Link to copy an invitation link to the operating system clipboard. Paste 
this link, for instance, to a meeting invitation email to allow Communicator participants to 
join the conference in one click from, for example, Outlook, or Office applications. Note that 
some applications may not recognize the Communicator (btbc:) link. You can also copy the 
My Room Invitation to the default email client (this text does not contain the Communicator 
link) and go to the My Room preferences via a right-click menu option. 

The link has two parts: one for Communicator users and another one for users with some other 
client. The invitation can also contain a link to the desktop sharing session. The invitation always 
contains a dial-in number and PIN for users who do not have Communicator. The desktop share 
link, when available, allows anyone to join a desktop share session from a standard web browser. In 
addition, the Communicator group chat session is supported with the web collaboration session. For 
guest user links, see the next section. 

The My Room info area indicates the conference bridge details of your My Room. You can also 
export the attendee list using the related participant menu available via the options icon (three 
dots). 

The Communications window also has an icon that provides the same Context menu 
previously discussed. 

For more information on desktop sharing, see section 7 Application or Desktop Share. Desktop 
sharing works the same way for both My Room and the ad hoc sessions. 

My Room uses your permanent chat room, permanent collaboration room, and conference bridge 
(audio or video). My Room is the only way to use the permanent rooms. Any other multiparty 
communications, such as selecting multiple contacts, and right-clicking for a conference call, or 
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dragging and dropping for a one-to-one chat, is done using ad hoc rooms. Ad hoc rooms are deleted 
once the session is over. 

All My Room sessions start as chats but call and/or share can be added to the session while in 
progress. File transfer and video conferencing are not supported in My Room or ad hoc sessions, 
additionally, you cannot transfer or conference My Room calls. 

You can also define that all users or only guest users need to be authorized to access My Room or 
that all users can automatically join. My Room invitations sent by you cannot be canceled in this 
release. 

My Room calls cannot be conferenced or transferred. 

In the Preferences → General tab, you can select to use an external Webex Meetings app for your 
My Room sessions. In that case, there is no synchronization of events between Communicator and 
Webex Meetings. 
 

8.1 Guest Client 

Previously it was not possible to join a full My Room session with a web browser. Guest client 
allows you to do that. 

This feature is especially intended for users outside of the company. Generate separate invitations 
for guest users using My Room right-click menu items as described in the previous section. My 
Room invitations are generated using separate menu items and are intended for Communicator 
users. 

Guest users can join a session with audio in the web browser by requesting a callback using the 
provided dial-in number and conference PIN as well as use group chat and sharing inside the web 
browser. However, guest clients do not have private chat possibility and they can see the chat 
history of messages that occurred after they joined the session. 

The invitations persist until reset via a separate right-click menu item. Individually accept each 
joining guest participant. Not doing this in a predefined period of time results in the invitation 
becoming obsolete and guests not being able to use the link to join. For more information, see 
section 6.15 Moderator Controls. 

After dismissing a guest user from share and chat, the audio/video portion can remain. 

The following OS and browser combinations are supported: 

 Latest Chrome on Windows (Windows 7, Windows 8 [Classic], and Windows 8.1 
[Classic]) and Mac OS (10.8 and 10.9) 

 Internet Explorer 11 on Windows (Windows 7, Windows 8 [Classic], and Windows 8.1 
[Classic]) 

 Safari 7 on Mac OS (10.8 and 10.9.) 

The following OS and browser combinations are supported if WebRTC is enabled by Masergy 

 Latest Chrome on Windows (Windows 7, Windows 8 [Classic], and Windows 8.1 
[Classic]) and Mac OS (10.8, 10.9, and 10.10) 

For more information on guest client usage, see Appendix B: Guest Client Usage. 

9 Universal Search 
Communicator supports a universal search of the enterprise directory, personal directory, 
enterprise common directory, and group common directory as well as chat messages and calls. This 
takes place in the same Search and Dial field that is used for calling and both a local and presence-
enabled contact list search, the results are separated onto their own tabs: 
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 Chat messages 

 Contacts 

 Calls 

The various directories have different purposes with the enterprise directory having the most data, 
and not all directories may be used in all deployments. All search results are combined into one 
common set of results. 

Personal directory, enterprise common, and group common directories cannot be modified from 
the client side. Only read access is provided. A snapshot of the presence status of the contact in 
the results list is shown, but this presence is not updated after the search operation. 

Personal directory provides your own special contacts that are not in the enterprise directory, for 
instance, partner company’s numbers while group common contains, for example, the group’s 
contacts such as favorite pizza taxi. 

Communicator automatically searches the local contacts and presence-enabled contact list in 
addition to the enterprise and other directories at the same time. As soon as there are results from 
the enterprise and other directories, these results are shown on a separate list in the Main 
window. Additionally, there may be other search result groups from other search sources such as 
LDAP or Outlook (native Desktop only). 

In a search, Communicator also supports Hiragana characters for the Japanese market. 

Search results are displayed differently depending on the results of the contact list and directory 
search: 

 If LDAP search (Corporate directory) or Outlook search are enabled, there are more result 
groups. 

 If there are no results for a certain search source (for example, local contacts, Outlook, 
LDAP, or BroadWorks Telephony Directory), then that group is different in the UI. 

The enterprise directory searches all available fields for the search string. By default, it waits for 
1.5 seconds before it sends the search request to the server to minimize unnecessary load on 
the server. 

Added support for department and title in directory search results as well as multi-part search 
string enhancements. However, the title field is not searched but when a match is found using 
other fields, the search results can have the title field when the data is available. The server will 
apply the AND operation for each search string part, and the order in which the individual parts are 
provided will not impact the search result. The enhancement applies all Xsi directories (enterprise 
directory, personal directory, group common, and enterprise common). For example: 

 While looking for Philip Moorefield, the following search string can be used: “Phil 
Moore”. An exact match of the first name is no longer required. 

 Looking for Joe Gold and using “jo go” or “go jo” as a search string provides the same results. 

 If Gregory Evermoore has for instance an email address 
“gevermoore@company.com”, he can be found using “ge” as a search string. 

Typically, when adding a contact using directory search results, there are phone numbers and first 
names in addition to last names available. In addition, the Extensible Messaging and Presence 
Protocol (XMPP) address and other fields are imported when found to allow presence and chat. 

LDAP search (Corporate directory) must be enabled by Masergy. In addition, the customer would 
need to provide the LDAP credentials so Masergy can enable the LDAP service. 

Outlook integration (search and calendar integration) on Windows requires one of the following 

mailto:gevermoore@company.com
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versions installed on the desktop: 

 Outlook 2013 

 Outlook 2016 

 Outlook 2019 

Outlook search also works when several Outlook accounts are in use, but only one account is 
used at a time (default selected, which can be changed in Outlook). Additionally, other 
related considerations are as follows: 

 The client searches for contacts and calendar entries in the default Outlook account. The 
account is set to the default via File → Info (left pane) → Account Settings → Account 
Settings → Data Files. Select an account and mark it as “Set as Default”. After making this 
change, sign out and sign back in to the client and it now searches that account for contacts 
and calendar entries. 

 The client searches the Outlook contacts only on the local machine (that is, the Outlook 
Address Book). There is no Exchange server lookup performed. In addition, all directories in 
Outlook are searched for contacts, even deleted folders. The Contacts directory can also 
have multiple levels of subfolders. 

Every minute, Communicator reads Outlook appointments. If there is an appointment running at 
the current time, then the presence is shown as Busy – In Meeting. 
Overlapping appointments are also handled. Following are some examples of Communicator 
operation with Outlook when time is 9:10 A.M. 

 

 There is meeting “A” 9 A.M. through 10 A.M. Presence is shown as Busy – In Meeting. 

 Presence is explicitly changed to Available at 9:15 A.M. Presence is shown as 
Available. 

 In the next minute, Communicator again reads the appointments and sees that “A” 
meeting is running; however, the presence was already explicitly marked as Available 
and presence is not shown as Busy – In Meeting but Available. 

 There is an overlapping meeting “B” 9:30 A.M. through 10:30 A.M. Presence is shown 
as Busy – In Meeting when the time is 9:30 A.M. 

When deleting a meeting that is currently ongoing in Outlook, the presence status remains as Busy 
– In Meeting until the next time Outlook appointments are checked (once every minute) and after 
that, presence is shown as Available. This change may be instantaneous or it may take a minute 
depending on how close the timer is to being triggered. 

The Outlook Object Security model was introduced in Outlook 2007; however, it is no longer 
supported in Communicator. It has been tested with Outlook 2010. For Outlook versions prior to 
2007, the Allow/Deny pop-up window seen in previous releases should not be triggered. However, 
those versions are not officially supported. For Outlook 2013, the behavior should be similar to 
2010, meaning the pop-up should not come up with Outlook 2010 and 2013 in Release 20.0.0 and 
onwards. 

The presence update is only triggered by appointments and meetings that are either accepted 
by the user or made by them. All day meetings do not trigger a presence change to Busy – In 
Meeting. 

10 Full Enterprise Directory 
Communicator allows for browsing of an entire BroadWorks enterprise directory. 

To view the enterprise directory, click the Directory button on the left-hand side of the navigation 
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pane. 

11 Communications History 
The fourth icon from the top in the Main window on the left-hand side of the navigation pane 
displays your call history. History view is divided into two tabs: 

 Calls 

 Visual voice mail 

Clicking a visual voice mail downloads the message so you can play it. 

Communicator saves a call history for placed, received, and missed calls. The call history makes it 
easy for you to redial and call back when you have missed a call or you want to easily dial a contact 
with whom you have recently spoken. Each call has a separate entry in the list. 

Chat history for group chats, both in My Room and in instant group chat, are stored locally on the 
Desktop client, just like in one-to-one chat, but only for the time the user is joined into the session. 
Look at individual chats by double-clicking the contact in the contact list or click the chat history 
icon in the left pane. 

Double-click on a name in the list to call back directly (this calls back the same way you 
previously spoke, for example, if you were in a video call, double-clicking starts a new video call). 
Double-clicking an incoming call item in the Calls tab makes a call. 

To clear the missed chat indicator, you must open the missed chat. 

The Call History missed communications badges can be cleared by using the right-click menu from 
the Call History button on the left pane (native Desktop only). The menu provides options to mark 
“All as viewed”, “Voicemails as viewed”, and “Calls as viewed”. 

12 Highlight to Call (Highlight Text) 
Support for Click-to-Call using highlighted text and global keyboard shortcuts. Users can highlight 
text anywhere in the desktop machine to make a call and define the default call type used for 
making the call using the shortcut defined in Preferences. On Mac OS, you must define the 
shortcuts on your own using the instructions provided in Preferences. The order in which key 
combinations are pressed may be significant in some cases if the operating system has reserved 
some key combinations for other purposes. 

The following possible combinations are not supported: 

 Ctrl + Alt + 1 

 Ctrl + Alt + 6 

13 Callto, Tel URL, and Other URL Schemes 
You can use Communicator for making calls using Callto, and Tel URL links anywhere in your 
machine, but you need to register Communicator as the primary application for that purpose in 
the operating system.  

On Windows, at first login there is a dialog asking if you would like Communicator to be the primary 
calling application for Callto and Tel URL schemes. Answering yes will modify Windows settings so that 
the next call using those links will use Communicator. If another application should afterwards take 
precedence in Windows settings, you can again make Communicator the primary calling application 
from Preferences, Outgoing Calls tab. 

On Mac OS, you must make the same selection in FaceTime preferences. You are required to log in 
to FaceTime to change the preferred calling application. 
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14 XMPP Security 
Communicator supports blocking of unauthorized file types in file transfer in order to support 
Masergy IT policies (native Desktop only). When sending a file with of an unauthorized type, there is 
an error message showing the cause of the file transfer failure. 

Similarly, clickable links in chat may be disabled; however, you can still copy the link into a browser. 
 

15 Outlook Add-in 
15.1 Introduction 

The Outlook Add-in for Communicator provides integration between Communicator Desktop 
and Microsoft Outlook. 

With this add-in, you can have Microsoft Outlook display Communicator contact presence and 
invoke Communicator functions like chat, call from computer, call from phone, and video call from 
within Outlook. 

 
15.2 Supported Platforms 

The following platforms are supported: 

 Microsoft Outlook 2013 (32 and 64-bit), and Microsoft Outlook 2016 (32 and 64-bit), 
Microsoft Outlook 2019 (32-bit and 64-bit), and Outlook Office 365. See the following note 
for exceptions. 

 Microsoft Windows 7 SP1, Microsoft Windows 8, Microsoft Windows 8.1, and 
Microsoft Windows 10. 

 Communicator Release 22.4.x or higher officially supported version. 
 

 
The following language and locale combinations are supported in the installer and the add-in: 

 Chinese (Simplified) 

 English 

 French 

 French (Canada) 

 German 

 Italian 

 Japanese 

 Korean 

 Spanish 

 Spanish (CALA) 

 Portuguese (European) 

 Dutch 

The following third-party components must be installed for the add-in to function correctly: 

 
NOTE: The current version of this add-in cannot be used if you have 
Microsoft Office Communicator or Skype installed. You must uninstall 
these products if you want to use this add-in. 
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 Microsoft .NET Framework 4.7.2 Client Profile 

This component is downloaded and installed by the installer if they are not found. They should not 
be uninstalled, as the add-in cannot functional correctly. Additionally, for Outlook 2016 and the 
Outlook Add-in (OL2016 Add-in), there are further considerations as follows: 

 The Outlook Add-in can only be installed by an administrator. 

 If an administrator installs for all users and a normal user starts using the OL2016 Add-in, 
Communicator must start before Outlook. 

 For logging to work normally, Communicator must start before Outlook. 

 Every logging level change requires a restart of both Communicator and Outlook for 
changes to take effect. This should be quite rarely needed. 

 If Outlook is closed while Communicator is running, Communicator must be restarted as 
well for the Outlook UI to behave as expected. 

 Communicator lists connected components as extensions, if connected is NO or if 
component version number is something other than 10.2.1.29, or both presence GW 
and add-in are not listed, an error has occurred. Component is visible under Options → 
Add-ins → UI, which displays registered and working add-ins on top, below stopped or 
non-working ones. 

 If both are listed and show connected is YES, but the Outlook UI does not work, restart 
both apps. 

 For Outlook upgrade requirements, see section 15.5 Outlook Add-in Installation. 

 For Outlook 2010, all contacts must be updated to have a SIP address. For Outlook 
2013/2016, the following applies: 

1) The SIP address does not need to be entered for the contacts, as long as there is an email 
address that matches the Outlook contact. The same value is looked for in the SIP 
address field, but it is probably more practical to have it in the email address. 

2) The Outlook Add-in allows you to choose which number to call. 

3) Two Outlook or Communicator contacts cannot have the same email address or IM 
address, otherwise full functionality cannot be guaranteed. 

 

 
 

15.3 Log Files 

Log files for the Add-in are located in the Communicator log directory. You can open the folder via 
Preferences → Advanced by clicking on the Show logs button. Outlook Add-in logging is turned on 
when Communicator logging is enabled. 

 

15.4 Windows Registry Entries 

The following table lists all the registry entries added or modified by the installer. 

 

 
 

 
NOTE: Communicator must be installed with administrator privileges in C:\Program 
Files OR theC:\Program Files (x86) folder. 
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Path Key Comment 

HKEY_CURRENT_USER\Software\Broad
Soft\Communicator\OutlookPlugin\olw
n d 

wnd Keeps Outlook applications window 
reference. 

HKEY_CURRENT_USER\Software\BroadSo
ft\OutlookPlugin LoggingLevel 

Logging level for Outlook plugin 
components. Its value as per 
Communicator Options → Advanced 
logging selection as follows: 
Basic logging on: 0x00000003 

Detailed logging on: 0x00000005 

Both off: 0x00000000 

HKEY_CURRENT_USER\Software\BroadSo
ft\InstalledBrandedBTBC 
Can also exist in 
HKEY_LOCAL_MACHINE (even under 
Wow6432Node). 

Example, 
OutlookPluginPath, 
CompanyName, 
ProductName 

These keys affect where the plugin is 
searched for when starting and where log 
files are written. 

HKEY_LOCAL_MACHINE\Software\Micr
osoft\Office\Outlook\Addins\Communi
cat or Add-in for Outlook 

LoadBehavior 0x00000003, based on this value Outlook 
loads the add-in dll. 

HKEY_LOCAL_MACHINE\Software\Micr
osoft\Office\Outlook\Addins\Communi
cat or Add-in for Outlook 

Description Communicator Add-in for Outlook. 

HKEY_LOCAL_MACHINE\Software\Micr
osoft\Office\Outlook\Addins\Communi
cat or Add-in for Outlook 

FriendlyName Communicator Add-in. 

HKEY_LOCAL_MACHINE\Software\Micr
osoft\Office\Outlook\Addins\Communi
cat or Add-in for Outlook 

Manifest $INSTDIR\plugins\Outlook$nOutlookBit
n ess\UC-Outlook-addin.vsto|vstolocal 

HKEY_CURRENT_USER\Software\IM 
Providers DefaultIMApp Communicator 

HKEY_CURRENT_USER\Software\IM 
Providers\Communicator UpAndRunning 0x00000002 

HKEY_LOCAL_MACHINE\SOFTWARE\I 
M Providers\Communicator FriendlyName BroadsoftIMApp 

HKEY_LOCAL_MACHINE\SOFTWARE\I 
M Providers\Communicator GUID {E3D1613A-93B2-4237-B4B8- 

B50595462C25} 

HKEY_LOCAL_MACHINE\SOFTWARE\I 
M Providers\Communicator ProcessName presencegw.exe 

HKCU\Software\IM 
Providers\DefaultIMApp 

UC-One Application 
name 

Needs to be taken by Communicator to 
be able to call, for example, call PSTN 
numbers from Outlook. 

15.5 Installation 

The Outlook Add-in installation is integrated with the Communicator installation. There is a check 
box in the installer to enable the Outlook Add-in installation. If Outlook is upgraded, the Outlook 
Add-in must be re-installed, since the Add-in uses different files depending on the Outlook 
version. 

The Outlook Add-in installation requires administrator rights to the computer for all Outlook versions. 
 

15.6 Features 
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15.6.1 Presence in Outlook 

The Outlook Add-in displays the presence of a contact in Outlook. Presence information is retrieved 
from Communicator and is displayed as an icon next to the contact in emails and calendar 
appointments. The following is an example of an email with the To, From, and Cc fields showing 
presence for various contacts. 

 

 

Figure Presence Displayed in Outlook 2010 
 

A contact’s presence can be Available, Away, Busy, or Offline as shown in the following figure. 
 

 

Figure Presence Values 
 

 

15.6.2 Contact Actions in Outlook 

The tab view of an email in your Inbox allows you to call or chat with the sender using 
Communicator. You have the option to Chat, Call (from Computer), or Video Call as shown in the 
following figure where mouse hovering provides the result depicted. Call from Phone is available in 
separate menus as the buttons are native to Outlook. The UX differs between Outlook versions.  

This section contains some examples of various versions. 

  

Figure Contact Options in Outlook 2013 
 

 

NOTE: You must be signed in to Communicator for the presence to be displayed. 
Additionally, presence is only shown for contacts that have a valid SIP address 
and are in your contacts list in Communicator. 
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These contact actions are also available on a contact card as shown in the following figure. 

 
Figure Contact Card in Office 365 

15.6.3 Call Multiple Phone Numbers Configured for Communicator / Non-Communicator Contacts 

You can call any of the multiple phone numbers present in the Outlook contact card. This feature is 
available from received mail context menu, flagged mail context menu, and Contact’s context 
menu. You can also call the selected phone number via Call, Call from Phone, and Video Call. 

However, you cannot call multiple numbers for contacts stored on the Communicator client or 
contacts in LDAP (AD) directories; only numbers stored in Outlook. 

See the following figure for an example of how to make the call from a contact card. 

  
Figure Contact Card with Multiple Numbers in Outlook 2016 

See the following figure for an example of how to make the call from the email item context menu. 

 
NOTE: Some of these options may not be available for all contacts. The chat 
option is only applicable to contacts that are in Communicator. Call options 
are applicable to all contacts. 
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Figure Email Item Context Menu in Outlook 2016 

 

15.7 Uninstall Outlook Add-in for Communicator 

Uninstallation is done together with uninstallation of Communicator. 

15.8 End-User Configuration 
 

15.8.1 SIP Address in Microsoft Outlook Contacts 
 

 
 

In order for the Outlook Add-in to integrate with Communicator, you must set a SIP address for 
each contact. The SIP address for a contact in Outlook must match the SIP URI, Instant Messaging 
and Presence (IM&P) address, or Email field in Communicator. This is usually done by your 
Microsoft Exchange or Active Directory administrator. 

You can check if a SIP address has been configured for contacts by looking at the Outlook profile for 
a contact. In Outlook 2010, open a contact card and then click on the View more options button. 

 

Figure Outlook 2016 Contact Profile – View Profile Menu 

The contact card should have a SIP address, email address or IM address as shown in the 
following figure. 

 

NOTE: This section is only applicable if you use Microsoft Exchange with 
Outlook. You do not need to configure the SIP address for SMTP-based 
accounts (for example, Google Mail). 
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Figure SIP Address for Outlook 2013 Contact 

 

In Outlook 2010, if the SIP address is missing, you can try to update the Address Book from the 
server as shown in the following figure. 
 

 

Figure Download Address Book in Outlook 2010 
 

Additionally, when adding contacts from Outlook to Communicator, the IM address field can be 
populated in Outlook so that the presence feature can work directly on the Communicator side as 
the information is imported to the Communicator contact card. 

16 Webex Contact Center Integration 
Communicator Desktop Communications window can be invoked from Webex Contact Center. In 
general, Communicator can be hidden with some tones and notifications disabled. 

17 Privacy Policy 
If you want to read the Masergy privacy policy that can be done by clicking the privacy policy 
link available in the About view. 

18 Accessibility Compliance 
Communicator supports accessibility compliance by having all client features available in menus at 
the top of the Main window (native Desktop only). The menu items are also available using the 
keyboard shortcuts listed in Appendix A: Keyboard Shortcuts for Desktop. 

Support for the following features: 

 Dictation 

 Screen reader (VoiceOver on Mac OS) 

 Keyboard navigation 
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The following limitations apply: 

 On Mac OS by default, the tab key moves the focus between text-inputs and lists. This can 
be changed through System Preferences → Keyboard → Shortcuts. Under Full Keyboard 
Access, select “All Controls” instead of “Text boxes and lists only”. 

 Dictation on Mac OS: If WebRoot SecureAnywhere is used, Pause Secure Keyboard Entry 
must be selected. 

 Users must manually select the correct language in screen reader. Communicator (UC-One) 
does not force screen reader's language according to the language selection in the client. 

 On Mac OS, the VoiceOver focus follows the VoiceOver Cursor. When VoiceOver is enabled, 
users are expected to navigate with the VoiceOver Cursor. That can be enabled through 
System Preferences → Accessibility → VoiceOver → Open VoiceOver Utility. In the opened 
window, open “Navigation” and check “Keyboard focus follows VoiceOver cursor”. 

 When using VoiceOver on Mac OS with different languages, the OS language, client 
language, and VoiceOver language must all be the same. 

Recommended Preferences → General → Accessibility settings for screen reader/VoiceOver are: 

 ToolTips disabled 

 Pop-up errors enabled 
 

19 Google Analytics 
Communicator can send analytics data to Masergy and/or Cisco (formerly BroadSoft) to 
improve the service. You can enable and disable this option in Preferences. 

 

20 Preferences 
Preferences provide access to available settings for Communicator. Follow these steps to access 
Preferences. 
 

Windows and Mac OS 

1) Click the Preferences logo in the Main window left pane. 

2) Select the desired view from the drop-down.  Or 
 

Windows and Mac OS 
1) Go to the Communicator accessibility menu. 

2) Select Preferences. 

3) Select the desired view from the drop-down. 
 

20.1 General 
 

Language 
Select your language then click OK or Apply and the change takes effect immediately.  

 

Login 
Enable or disable automatic login when starting the application and control the remember password 
feature as well. 

 

Notifications 
Usually there is a confirmation pop-up notification each time you remove a contact or chat history 
record. By selecting one or all of the check boxes, you can disable the confirmations when deleting 
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information. You can also control whether there is always a pop-up notification for publishing 
location information. Typically, this is shown at login. You can also select whether to receive a 
notification before ending communication or holding a call. 

 

Accessibility 
Enable pop-up errors allows Communicator error pop-ups to be shown in addition to the usual 
error text shown at the top of the Main window. 

Enable ToolTips is enabled by default. For accessibility, screen reader/VoiceOver reads all ToolTips, 
which may be frequent and hence disturbing. For this reason in accessibility cases, it is 
recommended to disable ToolTips. 

You can also enable spell checking and auto-capitalization. 

20.2 Audio/Video 
 

20.2.1 Audio 
 

Headset 
Here you can specify what are the output and input devices used for the headset when toggling 
between the headset and speakers. Note that to be able to toggle between the headset and 
speakers during calls, you must specify a different device for each. Using the default for both results 
in the same device being assigned to both so toggling does not work. 
 

Output Device (Voice Playback) 
Choose a headset, PC-integrated speakers, or external speakers for audio output. Your external 
playback device is selected by default (if you have one connected). 
 

Input Device (Voice Recording) 
Choose a headset microphone, PC-integrated microphone, or external microphone for voice 
during calls. Your external recording device is selected by default (if you have one connected). 
You can also choose automatic gain control and test your recording device. 

Speakers 

Here you can specify what are the output and input devices used for speakers when toggling 
between the headset and speakers. 

Note that to be able to toggle between the headset and speakers during calls, you must specify a 
different device for each. Using the default for both results in the same device being assigned to 
both so toggling does not work. 
 

Output Device (Voice Playback) 
Choose a headset, PC-integrated speakers, or external speakers for audio output. Your external 
playback device is selected by default (if you have one connected). 
 

Input Device (Voice Recording) 
Choose a headset microphone, PC-integrated microphone, or external microphone for voice 
during calls. Your external recording device is selected by default (if you have one connected). 
You can also choose automatic gain control and test your recording device. 
 

Ring Device (Alert Signal) 
Select the audio device that is played when you receive an incoming call. 
 

Ring Signal 
You can select your own ring signal. The same signal is used for both voice and video calls. If the 
Alert Info service is used, the network may instruct a certain ringing tone to be played. 
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You can also select an icon to play a tone for incoming messages. To disable the tone, uncheck 
the icon. Select a sound event and then click Play to hear the sound. If Alert Info service is used, 
the network may instruct a certain ringing tone to be played. 

 

20.3 Video 
 

Capture Device (Video) 
Select a camera that you want to use for video calls. Your external web cam is selected by default 
(if you have one connected). 

Video Size 
Select one of the available sizes. Note, however, that higher sizes require more 
bandwidth and a more capable central processing unit (CPU). It is recommended to use 
the lowest setting to save on bandwidth. 

 

20.4 Incoming Calls 

For the list of available call management services for incoming calls, see section 21 Call Settings. If 
Alert Info service is used, the network may instruct a certain ringing tone to be played. 

 

20.5 Outgoing Calls 

For the list of available call management services for outgoing calls, see section 21 Call Settings. The 
Review feature that you can enable in Preferences → Outgoing calls. Review brings you to the dial pad with 
the called number pre-populated so that you can modify or review it when you are using the default call 
type by for instance making a call from a web browser using Communicator. In addition, highlight to call 
and Register to call settings are available in Outgoing calls. 

 

20.6 Voice Mail 

You can specify various voice mail settings, such as which calls are sent to voice mail, what kinds 
of notifications you receive when voice mail arrives as well as controlling how fast the voice mail 
greeting is played and if callers are allowed to leave voice mails. In addition, you can control how 
callers can end up going to voice mail. 

 

20.7 Services 

In this release, this section is reserved for presence rules and Hub settings. For more 
information on presence rules, see section 6.20 Presence Rules and Silent Alerting. 

 

20.8 Integrations 

You can also manage extensions using the Communicator Application Programming Interface (API), 
which is used by third-party applications such as the Outlook Add-in or compatible headsets. You 
can allow such third-party applications to obtain information from Communicator and enable or 
disable confirmation pop-up notifications when third-party applications request information from 
Communicator. You can also choose default behavior to always reject or accept requests from 
third-party applications and allow or reject individual third-party applications. 

The following logic applies for accepting application requests: 

Every new third-party application opens a dialog asking for permission to connect. Your response is 
remembered (both negative and positive responses). 

 

20.9 Advanced 
 

The Advanced view contains three different subsections: 
 Troubleshooting 

 Proxy 
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 Credentials 
 

20.9.1 Troubleshooting 
Logging is used for troubleshooting. You may be asked by Masergy UC support to turn on logging 
and then send a log file directory contents. You can choose basic logging or more detailed logging 
to be enabled. Detailed logging may consume memory resources so it is not recommended to 
have it enabled for a long period of time. 

You can also clear the logs and open the logging folder as well as enable and disable Google 
Analytics. 

 

 

20.9.2 Proxy 

Select how to handle HTTP proxies. By default, the system settings are used but you can also 
choose not to use an HTTP proxy or to use the Communicator (client) proxy settings. 

 

21 Call Settings 
Communicator supports the following service management features allowing supplementary 
services to be managed using the Preferences and Incoming Calls and Outgoing Calls view 
available in the Main window left pane by selecting the appropriate sub-view in the drop-down: 

 Incoming calls 

− BroadWorks Anywhere 

− BroadWorks Remote Office 

− Forward Calls 

− Do Not Disturb 

− Simultaneous Ring Personal 

− Anonymous Call Rejection 

− Call Waiting 

 Voice Messaging 

 Outgoing Calls 

− Block My Number (Calling Line Identification Presentation [CLIP]/Calling Line 
Identification Restriction [CLIR]) 

− Automatic Callback 

− Highlight to call 

− Register to call 

You can also use the Call Settings with a Main window toolbar on the top of the window, if this 
feature is enabled. When enabled, this feature allows BroadWorks Anywhere, Do Not Disturb, 
Remote Office, and Call Forwarding to be managed in the Main window using single clicks or right 
clicks. The Call Settings toolbar is an icon in the left pane with right-click menus. 

 

21.1 Masergy (BroadWorks) Anywhere 

Masergy Anywhere simplifies communications for on-the-go users and remote users by extending 
the features of a desk phone to any other fixed or mobile device, regardless of the network or 
handset manufacturer. Callers dial one number and can reach you on any phone the user chooses. 
A desk phone, cell phone, and/or a soft phone may ring simultaneously. 
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Experience voice call continuity with the ability to move live calls from one device to another 
without hanging up. 

Add locations (numbers) that can be used in the service via the Add Number field. Use the Alert all 
locations simultaneously check box to activate parallel ringing. Click on the “+” icon to see more 
options. 

The Don’t divert check box prevents a call from ending up as a voice mail, which can be problematic in, for 
example, conference call situations. 

Select Answer Confirmation to receive a separate audio prompt when answering a call from that 
number (location). It may be useful in cases where, for example, mobile numbers are being used to 
prevent incoming calls going to mobile voice mail since the call will be ended without going to voice 
mail if the answer confirmation is not provided. Masergy highly recommends using this service to be 
enabled. 

Select the Call Control check box to enable the server platform to provide mid-call services such as 
Call Transfer and Conferencing for that number (location). 

 

21.2 Masergy (BroadWorks) Remote Office 

This service allows the use of any phone as the office phone from a charging and numbering 
perspective. For instance, a hotel room phone can be used as the office phone. 

Enable Remote Office by clicking the service icon and specifying a phone number to be used as 
the Remote Office number. 

 

21.3 Forward Calls 

Enter a number to which your calls should be forwarded. Different variants of Call Forwarding are 
supported, such as forwarding always, forwarding when busy, and forwarding when you cannot 
answer or when you are unreachable. In addition, you can specify the number of rings before Call 
Forwarding is triggered. 

 

21.4 Do Not Disturb 

When you activate this service, all calls are typically blocked by the server and are sent to voice 
mail. Enable this service by enabling the service icon. 

 

21.5 Hide Number 

You can hide or display your number when calling or communicating with other parties or contacts. 
Hide your number by enabling the service icon. To show your number, set this to “Disable”. 

 

21.6 Simultaneous Ring Personal 

Add up to ten additional numbers that you would like to ring in addition to your primary 
number when you receive a call. In addition, specify whether you want answer confirmations 
and if you would like to receive calls when already on another call. This service is an older 
variant of Masergy (BroadWorks) Anywhere. 

 

21.7 Voice Messaging 

You can enable or disable voice messaging in the Preferences and Incoming Calls tab. A number of 
settings are available: 

 Send all calls to voice mail. 

 Send busy calls to voice mail. 

 Send unanswered calls to voice mail. 

 Specify how voice mail messages are handled using an indicator in Communicator or 
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forwarding to email. 

 Enable notifications of new messages via email. 

 Email a carbon copy of new voice mail. 

 Transfer incoming calls to a specified number using “0” DTMF. 

 Specify how many rings are used before sending an incoming call to voice mail. 

 Allow/disallow callers to leave a message. 
 

21.8 Anonymous Call Rejection 

The Anonymous Call Rejection service allows you to reject calls from parties who have explicitly 
restricted their identities. 

You can enable or disable Anonymous Call Rejection in the Preferences and Incoming Calls tab. 
 

21.9 Automatic Callback 

The Automatic Callback (ACB) service allows you to be notified when the previously called busy 
party becomes idle and is connected without having to redial the phone number. 

When you call another party and the call cannot be connected because the line is busy, you are 
prompted to make an Automatic Callback request (for example, “The line you are calling is busy. 
Press 1 if you would like to be notified when the line becomes available”). 

If you select Automatic Callback, the system monitors the busy party and automatically establishes a 
call when the busy party becomes available. 

You can enable or disable Automatic Callback in the Preferences and Incoming Calls tab. 
 

21.10 Call Waiting 

The Call Waiting service allows you to answer a call while already engaged in another call. 

You can enable or disable server-based Call Waiting in the Preferences and Outgoing Calls tab. If you 
disable Call Waiting, the second incoming call is not connected and the caller hears an 
announcement that the call cannot be completed. Before you answer the first incoming call, the 
second incoming call will be rejected. 

 

22 Sign Out 
Signing out of Communicator sets your status to “Offline” for your contacts and displays the Sign 
In screen. 

 

22.1 Sign Out of Communicator 

To sign out, follow these steps. 
 

Windows 
1) Click the Communicator logo in the Main window title bar. 

2) Select Sign Out. 
 

Mac OS 
1) Select Actions from the main menu. 

2) Select Sign Out. 
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22.2 Exit Application 

To exit the application completely, follow these steps. 
 

Windows and Mac OS 
Close the Sign In window. 

 

Windows 
1) Select the Communicator logo in the Main window title bar. 

2) Click Exit (a keyboard shortcut can also be used). 
 

Mac OS 
1) Select Communicator from the main menu. 

2) Select Quit Communicator (a keyboard shortcut can also be used). 
 

 
 

23 Multi-Device Support 
Communicator supports users with multiple devices, according to the XMPP specifications. 
This is comprised of several features: 

 Chat invitations sent to a user are received on all devices. Once a particular device has been 
used to answer the chat invitation, subsequent incoming messages only go to that device. 

 One can retrieve one’s own presence notifications when another client updates the user’s 
presence. The client stores this information and updates its own presence so that it is the 
same as the higher priority status it received, (that is, when the received status update is 
manual). If the received presence update is not manual, it does not react to the received 
update; it only notes it. 

 Accepting a sharing presence invitation in one client is also recognized by another client, 
and both clients start receiving presence updates. 

 Last sent and received messages are available on all devices when the optional message 
history feature is in use. All devices should use that feature at the same time to avoid 
duplicate messages. Synchronization is triggered: 

− At login 

− When opening a new tab 

− When presence changes from idle (Away) to any other state 

− When changing presence from offline to any other state 

 Missed chat badges are synchronized across all own devices when this preview feature 
is enabled. 

 A new presence subscription made in one client is recognized in another. If the contact 
declines the “invitation”, there are presence notifications from the server to all of the user’s 
clients indicating that the subscription was terminated and this information is shown to the 
user. If the client receives two presence authorization requests from two or more devices for 
the same user, it only shows one request to the user. 

 

NOTE: Closing the Main window (not the Sign In window) does not exit the 
application but rather minimizes the application to the system tray (Dock). 
This allows you to continue to receive calls and messages without having the 
Contact List window appearing on the desktop. 
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 Removing a contact from the contact list in one device is recognized in another client and 
the contact list is updated (that is, the contact is removed) in the other client as well. 

If a user has many devices, each device has the same status when shown to the end user. In 
addition, the contacts on the contact list always see the same status with updates shown in the 
following priority order: 

 Busy 

 Online 

 Away 

 Offline 
 

This means, for example, that if one client publishes a Busy status and another client publishes 
another status, contacts see the user as Busy. Compatible devices such as desk phones are able to 
show presence in the same way. 

Communicator keeps track of its own presence status as well as the status of other devices and 
deducts the combined presence based on these. For more information, see Appendix D: Multi-
Device Presence.  

When Connect and Communicator Desktop are used together, the automated presence feature is 
recommended to be used to have presence shown fully in both clients as Connect does not use 
XMPP. 

When Connect and Communicator Desktop are used together, there are also some rules about 
location. Mobile applications have a concept of background and foreground mode to save device 
resources. When Connect comes to the foreground, it updates its location. 

The Desktop client does not have separate state for being on foreground; it only detects general 
usage of the device. The client can be on the background or foreground and based on idle detection 
it can drop to away. This requires that the computer is not used at all; moving the mouse/using 
keyboard triggers resuming to available again and it also resets the idle timer. Today, idle detection 
(or returning from idle) does not trigger location update on Desktop in this release. 

When both clients are set to automatic, the last one to publish location “wins”. As mentioned, 
Connect updates the location in automatic mode when coming to the foreground while Desktop 
does not have a similar concept. In addition, the last location update, initiated by you, manual or 
automatic, “wins”. 

When Communicator desktop is used together with Communicator Connect, offline presence usage 
on desktop may cause inconsistent presence status to be shown for mobile. 

 

24 Installation 
The installer supports a number of options on Windows (native Desktop only) as follows, only MSI 
installer is supported: 

 Run when system starts (can be changed later in Preferences). 

 Install Outlook Add-in. 

 Install for all users. 

 Create a desktop icon. 

 Select destination folder for installation. 

 Select the name of the software in the Program menu. 

 Launch the client after installation. 



 

Page | 46  

Agreeing to the license agreement takes place the first time the application is started, as on Mac 
OS. Note that two clicks are required to accept the EULA due to legal reasons. 

When installer has been run on an end user’s behalf by an administrator, the “Run program 
when system starts” option cannot be changed by that end user. 

If you disable startup, for example, in the Task Manager's Startup list (on Windows 8 and 
10) or from msconfig.exe on Windows 7, the change is not reflected in Preferences. The check box 
remains checked and grey even though the client is not actually started automatically when the 
system starts. 

The default language is the language of the operating system; if that cannot be found, English is 
used as the fallback. 

The Outlook Add-in installer is bundled together with the Communicator installer and requires the 
end user to enable this integration during the installation process. 

History is specific to the application name. If upgrading to another Communicator version that has a 
different application name, the history present in the other version is not available. 

Starting with the current release, only MSI installer is supported. 
 

25 Uninstallation 
The uninstallation procedure is different for Windows and Mac OS. 

 

25.1 Windows 

Uninstallation is performed by launching the Windows uninstaller via the Start menu or by using 
the Windows “Remove programs” view inside the Control Panel. Windows uninstallation does not 
require you to select any options. The language used for the Windows Start menu string “Uninstall” 
is taken from the language chosen when installing the client. This string cannot be changed after 
installation. 

All files are deleted at uninstallation, except for the following files: 

 Registry entries 

 Account files are only deleted when explicitly allowed by the end user on Windows. 

Note that as a result, some USB headset add-in files may also get deleted. For a workaround, see 
section 28 Troubleshooting.  

 

25.2 Mac OS 

Uninstalling is performed by simply dragging the application folder from the Applications directory 
to the trash can; however, account files are not deleted. If you want to remove account files, they 
must be manually deleted. These are the file locations for the account directories. The following 
locations apply for all account directories: 

For branded clients: 

/Users/<USERNAME>/Library/Application Support/<company_name>/<application_name> 
 

26 Version Control and Automatic Upgrade 
The end-users may receive a notification to upgrade Communicator to a newer version. Starting 
with Release 22.4, this upgrade may take place automatically after you accept it in a separate 
dialog. 

The upgrade may be recommended or mandatory. If it is mandatory, then Communicator does not 
start before the upgrade is done. 
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In automatic upgrade dialog you can choose between: 

 Remind Me Later – You will get a new pop-up at next login. 

 Skip This Version – You will not get a new pop-up for this version, but the next or if you 
manually check for updates in the menu. 

 Update Now – Upgrade is done immediately. 
 

27 System Requirements 
System requirements are as follows on native Desktop: 

 Operating system: Mac OS 10.12 Sierra, Mac OS 10.13 High Sierra, Mac OS 10.14 Mojave, 
Mac OS 10.15 Catalina, Mac OS 11.0 Big Sur, Mac M1 chip (arm), Windows 8/8.1, or 
Windows 10 (Classical view only). 

 The installation footprint is approximately 125 megabytes (MB) on Mac OS and 215 MB on 
Windows. 

 For voice calls, a sound card, speakers, and a microphone or a headset are required. 

 For video calls, a web cam is required. 

Minimum system requirements for respective operating systems need to be fulfilled, with the 
following additions: 

 A minimum of 4 GB random access memory (RAM) is required. 

 A minimum 1.5 GHz CPU is recommended. A dual core CPU is recommended for video calls 
at a minimum. 

 

For high definition (HD) video, the following is recommended: 

 HD camera 

 HD resolution support in display 

 Quad Core x86 or equivalent at a minimum 

 4 GB RAM 

Virtual Desktop Infrastructure (VDI) environments are not supported. 

28 Troubleshooting 
Why am I getting a Windows Defender popup when launching Communicator? 

 

Sometimes Windows Defender may report an issue when initially launching applications such as 
Communicator. In that case, click “Allow”. If you do not have administrative permissions to your 
machine, contact your system administrator. 

 

Why are my Emojis showing as black boxes? 
The Segoe UI font is required for the Emojis to appear correctly. For more information on installing 
the Segoe UI font, see the following article: 

https://support.microsoft.com/en-us/help/4021341/emojis-are-not-displayed-in-office- 
applications-in-windows-7 

However, on Windows 7, some Emojis do not work despite this as listed in the following table. 
  

https://support.microsoft.com/en-us/help/4021341/emojis-are-not-displayed-in-office-
https://support.microsoft.com/en-us/help/4021341/emojis-are-not-displayed-in-office-applications-in-windows-7
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Emoji Number Code 

1 x1f600 

5 x1f615 

7 x1f61B 

9 x1f62E 

11 x1f61F 

15 x1F611 

17 x1F913 

18 x1F634 

19 x1F644 

20 x1F922 
 

Why did I lose chat history after an upgrade to a renamed Communicator? 
When installing a Communicator version that has a different application name, the history is specific 
to that application name. If the application name remains the same in the upgrade, the previous 
history is available. 

 

Why can’t I chat with contacts from Yahoo? 
Chatting with users in other domains is possible but depends on the domain. For instance, 
BroadCloud supports Google federation but not Yahoo. However, group chat is not supported in 
Google federation, so the group chat option with those contacts is shown in grey. 

 

Why can’t I change the avatar? 
Double-clicking the avatar should open a File Explorer view to select a file. If your XMPP connection 
is lost, changing the avatar does not succeed. A lost XMPP connection is indicated in the Main 
window’s top notification area. 

 

My contacts are all offline and my client’s status bar says “XMPP unavailable”. What does this 
mean? 
It means that the XMPP connectivity has been lost for chat, as well as for presence; however, 
you can still make calls.  

 

Why am I offline? 
If you have selected “Offline” status, you are shown as offline to others. Another possibility is that you 
may have lost your Internet connection. In this case, the client does not log out, but rather enters an 
offline mode where a contact list is available but communication is not possible. 

 

Why can’t I have more video resolutions available? 
You can choose your video resolution from Preferences and the Video tab. Your selection is used by 
default for future video calls. The available resolutions are automatically presented based on your 
camera. 

 

Why can’t I change my user name and password? 
User name and password editing is not supported in the client. To edit your user name or password, 
contact Masergy UC Support.  

 

Why does my all day calendar entry not trigger Busy – In Meeting presence status? 
Not all meetings trigger a presence change to Busy – In Meeting. 
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To trigger the presence update, the meeting must be in the Show me as busy state. 
 

Why aren’t all my group chat messages saved? 
Only the newest chat room messages are stored on the server, but never for My Room for security 
reasons. Starting from Release 21.3.0, when the optional (Preview mode in Release 21.3.0 and fully 
supported in Release 21.4.0) message history feature is enabled by Masergy, messages sent from 
other devices are also shown. 

 

Why aren’t all my chat messages available in my other devices? 
All one-on-one and group chat messages are saved, but only locally, so they are not necessarily 
available in your other devices. Incoming messages are sent to all devices; however, the ones that 
you send are only stored in the device that you are using to send the message. Starting from 
Release 21.3.0, when the optional (Preview mode in Release 21.3.0) message history feature is 
enabled by Masergy, messages sent from other devices are also shown. 

 

Why can’t I change the XMPP address of a contact? 
This is not supported in this release. However, you can delete the contact and add a new one. 

 

Why does my location show an incorrect address? 
It is done based on the public IP address that the machine is using. The IP address is mapped to 
a physical location. Cisco (formerly BroadSoft) is working with the mapping provider to improve 
the accuracy of the location. You can also manually change the location by clicking the avatar 
and changing the location icon. 

Why can’t I start desktop sharing? 
To share your desktop, you need to have valid credentials, either by manually entering desktop 
sharing credentials in the Preferences → Credentials window, or by using auto- provisioning to 
enable the desktop sharing menu items and icons. However, you can participate in desktop sharing 
sessions even without any sharing credentials.  

 

I have a USB headset and the Call Control features are not working. Is there anything special I 
need to do to enable Call Control support? 
In order to use headsets on Windows (not supported on Mac OS), several steps are needed: 

1) When the client is started, you must accept the API connection request from the 
connector/add-in device. 

2) Additionally, your client must have the feature enabled by Masergy. 

3) If your USB headset uses its own add-in, the standard human interface device (HID) Add-in 
from Cisco (formerly BroadSoft) must be disabled, as both cannot be used at the same time. 
In addition, you must have “Allow 3rd party extensions” check box checked in Preferences → 
Extensions tab. 

4) After upgrading Communicator, some USB headset add-ins may get deleted causing call 
control to not work and the add-in to not be visible in Preferences. As a workaround, 
repairing/re-installing the add-in software corrects this. 

 
Why is the Outlook Add-in disabled? 

If the context menu does not show Add-in menu items, this could be due to the Outlook Add-in 
disabled by Outlook for slow loading. This happens primarily in Outlook 2013. In such cases, enable 
this add-in by selecting the Outlook menu → File → Info → Manage Add-Ins → Communication 

 
NOTE: For troubleshooting USB headset issues, advanced logging is recommended. It 
can be enabled in Preferences → Advanced view. 
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Add-in → Always enable this add-in from the displayed menu (as shown in the following figure). 
 

 
Figure Outlook Account Information – Add-in Disabled 

 

Why is presence not showing in the Outlook Add-in? 

If the presence indicator icon is not shown in Outlook, verify any of the following software is 
installed: 

• Microsoft Office Communicator (OCS) 

• Microsoft Lync/S4B 

• Skype version 6.1 or above 

Uninstall each one found and restart Outlook and the Communicator client. 
 

 
 

 
Figure Microsoft Office Installation Example 

 

How do I disable/enable the Outlook Add-In from Communicator Preferences view? 

To enable/disable Outlook contact presence status (5.1 Presence in Outlook), from the 
Communicator Preference page, the “Communicator Outlook Add-in, Gateway process” check box 
option must be checked/unchecked. 

 

 

NOTE: During Office/Outlook 2013 installation, the installer installs Microsoft 
Lync by default. You must uncheck Microsoft Lync (as shown in the following 
figure) and then proceed with the installation. 
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Figure Communicator Preference Page 

 

To enable/disable the Outlook context menu related to the add-in, from the Communicator 
Preference page, the “Communicator Outlook Add-in” check box option must be 
checked/unchecked. 

 

 
Figure Communicator Preference Page 
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Why are Outlook Add-in IM buttons sometimes are greyed out in the quick contact page, even though 
the user is logged in? 

Sometimes IM buttons are greyed out on the contact page. When mouse over it, it shows the 
message “To use this feature, sign in to an instant messaging program". 

 

 

Figure Outlook Add-in IM Buttons Issue 
This seems to be a Microsoft issue, and the workaround to solve is to restart Outlook. 
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Appendix A: Keyboard Shortcuts for Desktop 
 

The following table lists the currently supported keyboard shortcuts (native Desktop only). You can use these 
keyboard shortcuts to quickly perform frequently used actions. The characters used are lower case. The 
shortcuts are also indicated in the accessibility menus. 

 

Shortcut for 
Windows 

Shortcut for 
Mac What it does 

CTRL-Q Cmd-Q This quits the application. 

Alt+F4 Cmd-W This closes the selected window (except for a contact card and 
the About window). 

CTRL+C Cmd-C This copies selected text from Communicator to the clipboard. 

CTRL+V Cmd-V This pastes text from the clipboard to the location selected 
using the cursor in Communicator. 

CTRL-X Cmd-X This cuts the selected text to clipboard. 

Enter Enter 

When in the Communications window, this sends a chat message 
(if the Chat view is visible). 
When in the contact list, this opens a chat with the selected 
contact. 
When in the Communications History, this opens a 
communications session with the contact or address related to 
the selected item. This opens a chat if the item was chat and a 
call if the item was a call. 

-, Cmd-, This opens Preferences. 

F1 Cmd-? This opens Help. 

CTRL+A Cmd-A This selects all text in the Chat view. 

- Cmd-H This hides Communicator. 

- Alt-Cmd-H This hides other windows other than Communicator. 

CTRL-N Cmd-N This opens the Add Contact window. 

Shift-CTRL-N Shift-Cmd-N This opens the Add Group window. 

CTRL -1 Cmd-1 When a contact is selected, this opens a chat session with the 
contact. 

CTRL -2 Cmd-2 When a contact is selected, this calls the contact with audio. 

CTRL -3 Cmd-3 When a contact is selected, this calls the contact using call from 
phone. 

CTRL -4 Cmd-4 When a contact is selected, this calls the contact with video. 

CTRL -5 Cmd-5 When a contact is selected, this joins their room. 

CTRL -6 Cmd-6 When a contact is selected, this opens an email-sending window 
using the default email client. 

CTRL -I Cmd-I When a contact is selected, this opens the contact card for the 
contact. 

Shift-CTRL-F Shift-Cmd-F When a contact is selected, this makes the contact a favorite. 
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Shortcut for 
Windows 

Shortcut for 
Mac What it does 

CTRL-delete Cmd-delete This deletes the selected contact. 

CTRL-arrow 
down 

Cmd-arrow 
down This decreases the volume. 

CTRL-arrow up Cmd-arrow up This increases the volume. 

CTRL-space CTRL-space This mutes the client (while in a call). 

CTRL-D Cmd-D This turns on the Do Not Disturb service. 

CTRL-P Cmd-P This pulls an ongoing call from your other device to 
Communicator. 

Alt-shift- CTRL-P Alt-shift-
Cmd-P This retrieves your parked call. 

- Alt-Cmd-2 This calls your voice mail with audio. 

- Alt-Cmd-3 This calls your voice mail with audio using call from phone. 

- Alt-Cmd-4 This calls your voice mail with video. 

Shift-CTRL-R Shift-Cmd-R This opens your My Room. 

CTRL-M Cmd-M This minimizes the window on Mac OS. On Windows, it only is 
used for the Team Telephony window. 

CTRL-T Cmd-T This enables always on top. 

- Shift-Cmd-M This opens the Main window. 

Shift-CTRL-C Shift-Cmd-C This opens contacts. 

Shift-CTRL-F2 Shift-Cmd-F2 This opens call history. 

Shift-CTRL-F1 Shift-Cmd-F1 This opens chat history. 

Shift-CTRL-F3 Shift-Cmd-F3 This opens visual voice mail. 

Shift-CTRL-D Shift-Cmd-D This opens the dial pad view. 

Shift-CTRL-W Shift-Cmd-W This opens the web button view. 

Shift-CTRL-O Cmd-O Causes Communicator to logout. 

Ctrl-7 Cmd-7 Answer incoming call with audio. 

Ctrl-8 Cmd-8 Answer incoming call with video. 

Ctrl-9 Cmd-9 Decline incoming call. 
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Appendix B: Guest Client Usage 

This section provides more hands-on information about guest client usage. 

1) Right-click on the My Room icon to copy the guest join link and send it to a guest via email or other means. 
You can also use the Copy Guest Link feature in My Room. 

 

Figure Copy Guest Join Link Menu Option 
 

2) The guest can open the link in one of the supported browsers, enter their name and password, and then 
click Join Room. 

 

Figure Login Screen for Join Room 

3) Once you click on Join Room, you see a notification on your My Room (as shown in the following figures). 

     
Figure My Room Icon – Guest Request Badge 

 
The guest can join the video portion of the session by clicking on the video button. 

The guest can switch between audio and video mode by clicking on the video icon. They can also mute 
and end the call by clicking on the mute and end call icons respectively. 

The guest can show or hide their self-view by clicking on the video icons in the bottom part of the window. 
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4) Open your My Room and accept the guest request. The video call is resized and moved to the bottom 
row. 

 

Figure My Room – Desktop Share with Video 
 

5) The guest is allowed into your room and can now participate in multi-user chat with other participants in 
the room (as shown in the following figure from a browser). 

 

Figure My Room – Desktop Share with Video Call 
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Appendix C: Configure USB Headsets 
 

This section provides more information on configuring USB devices to function with Communicator. 
Note that some headset manufacturers have built their own add-ins for Communicator (UC-One), 
for instance, Jabra on Windows. In this case, the standard HID Add-Ins cannot be used at the same 
time. You can enable and disable add-ins in the Preferences → Extensions view. 

In general on Windows, if “Default Communication Device” is defined in Windows settings, it is 
selected over the “Default Device” by Communicator for calls when several audio devices are 
available (for example, USB headset and the integrated audio device on the PC). However, when 
using headsets, you can select a separate device than the headset for alerting incoming calls. 

The following examples provide more information on how to define a default communications device 
when a USB headset is available on the PC. 

It is recommended to select “Use Default” in the Media tab of Communicator Preferences for both 
input and output devices (as shown in the following figure). 

 

Figure Preferences Window 

1) To define the default communications device, make sure that the Sound settings in Windows 
pertaining to “Recording” and “Playback” devices are correctly configured. From the Sound 
applet, select the Playback tab. 

 
Figure Sound Window – Playback Tab 
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In this example, the user has a Plantronics BT300M (the USB dongle accompanying a Voyager 
Legend UC) connected to their PC. 

2) Click Headset Earphone to highlight the device and click on the drop-down arrow next to the 
Set Default button. 

 
Figure Sound Window – Playback Tab – Set Default 

3) Select Default Communication Device. The following screen is displayed. 

 
Figure Sound Window – Playback Tab – Default Set 

4) Next, click the Recording tab. 

 
Figure Sound Window – Recording Tab 

 

5) Again, click on Headset Microphone, which represents the connected Plantronics BT300M 
device, and click on the drop-down arrow next to the Set Default button. 



 

59 | P a g e  

 

 
Figure Sound Window – Recording Tab – Set Default 

6) Select Default Communication Device. 

 
Figure Sound Window – Recording Tab – Default Set 

 
7) Click OK to save the changes. The Sound window is dismissed and your device is now ready to be 

used by Communicator. 
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Appendix D: Multi-Device Presence 
 

This section provides a table describing the presence state changes based on the presence state that 
Communicator has as well as the presence status of other devices that the same user has active. There is a 
distinction between what is shown in the UI and what is the internal presence status of the Communicator 
client since the design is to show the same own presence in the UI of all own online devices. The following table 
is applicable from Release 21.3.0 to 21.6.0 when the presence aggregation feature is not used. Earlier releases 
have slightly different behavior in some cases. The table describes presence state changes when steps 1 
through 6 are executed in order, starting from step 1 and continuing through to step 6. 

 

 

The previous scenario happens when typing or mouse movement occurs on the desktop machine in 
steps 4 and 6. If this is not done, then the away status would be the desktop’s “own” presence and 
the table would look as follows (same states in the beginning and different ones marked in green). 
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Appendix E: Third-Party Software and Copyright 
 

The list of third-party software used in Communicator (UC-One) is available be from the following link: 

https://www.cisco.com/c/en/us/about/legal/open-source-documentation- 
responsive.html?flt0_general-table0=UC-One 

  

https://www.cisco.com/c/en/us/about/legal/open-source-documentation-responsive.html?flt0_general-table0=UC-One
https://www.cisco.com/c/en/us/about/legal/open-source-documentation-responsive.html?flt0_general-table0=UC-One


Appendix F: Acronyms and Abbreviations 

This section lists the acronyms and abbreviations found in this document. The acronyms and 
abbreviations are listed in alphabetical order along with their meanings. 

ACB Automatic Callback IP Internet Protocol 

ACD Automatic Call Distribution LDAP Lightweight Directory Access 
Protocol 

API Application Programming 
Interface LGPL Lesser General Public License 

CPU Central Processing Unit MWI Message Waiting Indication 

DND Do Not Disturb RAM Random Access Memory 

DTMF Dual-Tone Multi-Frequency SAML Security Assertion Markup 
Language 

ECACS Emergency Call Address Change 
Service SIP Session Initiation Protocol 

EULA End-User License Agreement SSO Single Sign-On 

FAC Feature Access Code UC Unified Communications0 

FAQ Frequently Asked Question UI User Interface 

FMC Fixed-mobile Convergence URL Uniform Resource Locator 

GUI Graphical User Interface UVS BroadWorks Video Server 

GW Gateway VDI Virtual Desktop Infrastructure 

HD High Definition VoIP Voice over IP 

HID Human Interface Device WebRTC Web Real-Time Communication 

IdP Identity Provider XMPP Extensible Messaging and 
Presence Protocol 

IM Instant Message Xsi Xtended Services Interface 

IM&P Instant Messaging and 
Presence UC-One Communicator 

CONTACT US: USA +1 (866) 588.5885 | UK +44 (0) 207 173 6900 | sales@masergy.com 
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